

 Advancement Office Resource Manual
















THE SAVANNAH COUNTRY DAY SCHOOL

	19960311_JC_000062


     




GIFT HANDLING
Receiving Gifts
Honor/Memorial Gifts
Stock Gifts [All Funds]
Cash, Checks & Written Pledges
(see below for Payroll Deduct & AF multi-year pledges)
Annual Fund MULTI-YEAR Pledges
Matching Gifts
Credit Cards
Manual Entry
Online Credit Cards Donations for Horizons
Gift Posting in Raiser’s Edge (Re)
Importing through Online Express
Manual Entry of Checks/Cash & Pledges
Employee Payroll Deductions Monthly Batch Entry
General Posting
Gifts on behalf of Others
Annual Fund multi-year Pledges from Graduating Seniors
Annual Fund multi-year Pledges
Annual Fund Online Recurring Gifts
Stock Gifts (All Funds)
Employee Payroll Deductions Monthly Batch Entry
Annual Fund Gifts
Annual Fund Gifts on behalf of another individual
Matching Gifts
Restricted Gifts
Capital Campaign Gifts
Horizons Gifts
Calendar Year End
Fiscal Year End
Retention of Postings
Acknowledgment Letter Processing
Generate Acknowledgment Letters from Raiser’s Edge
Add a New Acknowledgment Letter to Raiser’s Edge
Endowment
Communications Support
List of Grads with Parent or Grandparent Alums/Class Associates
Mailings
Images
Annual Report
Hornet Connection
Annual Fund Campaign
Calendar
Summer Tasks
Solicitation Hierarchy
Solicitation Recommendations
Fall
Spring
May
Volunteers
Job Descriptions
Training Manual Information
Signature Form
Confidentiality Agreement
Code Volunteers/Solicitors in Raiser’s Edge
Code Solicitor
Assign Solicitors to Prospects in Raiser’s Edge
Add Verbal Pledge to Raiser’s Edge
Prospect codes in Raiser’s Edge
Constituent Classification options
Constituent Prospect Status options
Code a Constituent as “Do Not Solicit” in Raiser’s Edge
Pledge Reminders from Raiser’s Edge
Report
Reminders
Annual Fund Solicitation Lists from Raiser’s Edge
Adding Group Appeal Codes
Adding Group Package Codes
Parents
Grandparents
Alumni & Class Associates
Parents of Alumni (aka past parent)
Headmaster’s Council
Annual Fund Monthly Analysis
Queries for The Fund Analysis
Analysis Spreadsheet Report
Annual Fund Detail Reports
Parent Class Analysis
Alumni & Class Associates Class Participation
Phone-a-thons
Car Decals
Gifts for Volunteers
Green & Gold Dinner Invites
Annual Audit Procedures
Reports
1.	Cash Flow Reports
2.	Gift Detail Reports
3.	New Pledge Reports
Confirmation Letters
Form 990 Schedule of Contributors
Annual Report Proof
Parent Proof
Alumni Proof
Annual Report
ONLINE EXPRESS (OLX)
Handling Bounced Emails
RAISER’S EDGE CONSTITUENT DATA
Annual Data Roll & Updates
Data Roll Checklist
Data Roll Instructions
Adding New Records
New Parents
New Students
New Employees
Adding New Attribute Codes
Addressee/Salutation Standards
Constituent Rules (pop-up notes on records)
User Defined Rules in Raiser’s Edge
ADVANCEMENT OFFICE NEW HIRE
New Hire Checklist
SOFTWARE SET-UP AND SECURITY
Citrix Hosting Site New User
Raiser’s Edge New User
Raiser’s Edge Nxt New User
Printer/Copier New User (Ashley’s machine # 19768)
REFERENCE CHARTS
Stock Brokerage Firms
General Ledger Codes (Created by Business Office)
General
Restricted
Endowment Capital Funds
Endowment 1981 Permanently Restricted
Acknowledgment Letter Types
Annual Fund Pledges
Annual Fund Gifts
Capital Campaign Pledges
Capital Campaign Gifts
Capital Campaign Special Gifts

[bookmark: _30j0zll]



GIFT HANDLING
Receiving Gifts
All gifts are received into the Advancement Office by the Director of Annual Giving (DAG), placed in alpha order and given to the Advancement Assistant.
Honor/Memorial Gifts
[image: ]If a gift has been made in honor of memory of an individual, you will print them on a SCDS logo fold-over notecard. Notify family member(s) of the donation. When posting the gift, the information will be added to the Tribute tab on that gift record.

	Sample: 
Stock Gifts [All Funds]
There are various ways that you may receive notification of a stock gift. Sometimes it is via a telephone call from the brokerage firm, or you may receive a printed statement from the firm. When notification is received, direct the brokerage firm to sell the stock immediately.

· Determine the donor gift date.  This is the date that the stock was transferred into the SCDS account and not necessarily the date it was sold.
· Determine the number of shares, name of stock, and stock symbol being sold.
· The donor receives tax credit for the average of the High and Low on the GIFT date which will vary from the actual receipt amount.
To determine this, visit www.finance.yahoo.com and search for the stock, select ‘Historical Prices’ and enter the gift date information to determine the high and low for that day.
1. Determine the average of the High and Low. Example below based on information above data:
High: 29.64 + Low: 29.64 ÷ 2 = Avg: 29.64 × # of shares = value credited to donor
2. See Stock Gift under ‘Gift Posting in Raiser’s Edge (P. 12)
Cash, Checks & Written Pledges
(see below for Payroll Deduct & AF multi-year pledges)
· Scan each check, cash or pledge along with any documentation attached.
· Group checks/cash alphabetically by Fund.
· Attach a post-it note to the first check in each group, recording the correct Fund Name & GL Code. (Refer to the Reference Section (P. ??) for GL Codes.
Note: Be sure to note the correct GL Code for Annual Fund multi-year pledge payments booked with the Business Office.
· Stamp the back of each check ‘For Deposit Only’
· Submit original checks to the Business Office:
Annual Fund unrestricted gifts are submitted to Brenda Cobb (green envelope).
All other gifts are submitted to Emily Foley (pink envelope)
· Generate Honor/Memorial cards
· Retain scanned copies for posting and digital filing.
Annual Fund MULTI-YEAR Pledges
Written Annual Fund Pledges that fall into multi fiscal years must be reported to the Business Office.
(see below Gift Posting section)
Matching Gifts
· Pull the Matching Gift Log from file and note the date the gift was received.
· Fill out form and have it signed by the Director
· Keep a copy on file and submit the original to the MG Company
· Add gift to the Matching Gift Log and file copy with the log.
Credit Cards
Manual Entry
· Process gift through school website posing as the donor or enter it through the BBMS website.
(Enter your email instead of the donor’s)
· Immediately delete/shred any credit card information. Do Not keep credit card information on file.
· Donations entered (when posing as donor) will show up via Online Express (OLX). See next section on Gift Posting.
· Donations entered through the BBMS website will not show up on OLX and must be manually added to RE. (see next section on Gift Posting.
Online Credit Cards Donations for Horizons 
· These gifts are “handled” through the Whipple Hill website by the Advancement Assistant.
· The Horizons Director will notify via email that an online gift has been received.
· Login to the Whipple Hill website
· Select > On Message > Approval > Giving
· Open the gift in .pdf 							


Gift Posting in Raiser’s Edge (Re)
Importing through Online Express
[image: ]Redesign the batch using Batch Design tool.
Add the following fields: Letter Code, Send Reminders, Attributes: Special Gift Code attribute description & Special Gift Code attribute date
Select Data Entry

For Credit Card Gifts add the following:
		Letter Code: Select the appropriate letter
Appeals: Add based on Appeal
Package: Add based on Package

For Employee Payroll Pledges add the following:
		Letter Code: Select the appropriate letter
Appeals: Add based on Appeal
Attributes:	Special Gift Code attribute description = Payroll Deduction & Special Gift Code attribute date = 9/1/2017 (or current FY)
Package: Add based on Package
From the top menu bar, select Gift > Installment Information and enter the following parameters and the payment amounts will be distributed properly.
[image: ]















Commit the Batch
Manual Entry of Checks/Cash & Pledges
For Cash/Checks use recurring Batch #200
		Enter all required fields
		Globally change date
		Commit the Batch

For Payroll Pledges use recurring Batch #1200
		Enter all required fields
From the top menu bar, select Gift > Installment Information and enter the following parameters and the payment amounts will be distributed properly.
Commit the Batch
Employee Payroll Deductions Monthly Batch Entry
You will receive a list of these each month from the Business Office.
Open the Batch module in Re
· Select Batch #500
· Click on the ‘Date’ column in the green row
· Select the ‘Tools’ button and ‘Global change Date’ to current month
· For Value: Enter a date (I like to select a date that no other posting is taking place so that I can easily run a separate report of these postings. A weekend date is okay to use).
· When pop-up appears, click the box to overwrite existing value.
· Repeat the two steps above in the ‘GL Post Date’ column in the row highlighted in green.
· Review line by line and compare to report from Business Office and update as needed.
After completing updates and confirming total, Select “!” to process batch entry
General Posting
See below section for gifts on behalf of others. Eg: Foundation gifts or gifts on behalf of other individuals.
· From the Constituent Module in Re, open constituent record by entering donor name to search.
· Open the constituent record
· Review contact information for any updates to be made (Also make updates to the record in Whipple Hill).
· View the Appeals tab and make note of any appeal from current fiscal year.
· Select the Gifts tab
· Look for any outstanding pledge that may need a gift to be applied. 
· Select New Gift tab
· To apply a gift towards a pledge on a different record, from the New Gift top menu screen, select Gift, Apply to, Load Pledges from and search for that record.
· If a pledge is on the record, a pop-up box will appear asking if you wish to apply the gift towards a pledge. Note: only apply to the pledge if it is for the same Fund.
· Enter Gift subtype as Online Donation or Online Pledge if applies
· Enter date received (or will default to today’s date)
· Enter Amount
· Enter Campaign, Fund & Appeal
· Enter letter type (based on letter grid in the reference section of this book)
· Enter pay method
· If check, enter check # and date
· If credit card, enter card type (If entered via manual machine, enter approval code)
· If donor specified to be Anonymous, select Misc tab
· If the gift is in honor or memory of someone, add that information on the Tribute tab.
· If Tribute name not found, you will need to open the particular tribute’s record, select the Honor/Memorial tab and add that information prior to adding them to the gift.
· Save and Close
Gifts on behalf of Others
IRS regulates that a gift must be posted to the donor record of whom it is actually received, even though it may be made on behalf of another individual. E.g.: Foundation gifts or gifts on behalf of other individuals or gifts made by a parent on behalf of their child alum.
Note: Gifts may be applied to outstanding pledges on “other” records.

Open the record of the individual the gift was made on behalf of.
· View the Appeals tab on the record the gift is made on behalf of and make note of any appeal from current fiscal year. If there is an appeal, enter “Gave” as the Response.[image: ]




[image: ]
· If the gift qualifies the individual for a specific level of giving, open the Attributes tab and code as follows: E.g.






Open the actual Donor record.
· Add an Attribute as follows (unless the individual has already made a gift the current FY donation).
This will include them in a query called AF Gifts 15-16 on behalf of others. This query will be added to Solicitations by the Director of Annual Giving.[image: ]

· Follow General Posting in above section. To apply a gift towards a pledge on a different record, from the New Gift top menu screen, select Gift, Apply to, Load Pledges from and search for that record. Apply accordingly. Note: only apply to the pledge if it is for the same Fund.
· Enter the correct Appeal from the record the gift is intended for.
· Soft-Credit the gift to the record the gift is intended for.
Annual Fund multi-year Pledges from Graduating Seniors
When posting multi-year pledges for graduating seniors, you will enter the following to be sure they are excluded from monthly cash flow reports for the Business Office
· Select the Attributes tab, enter the Category: Special Gift Code, Description: Senior multi-year pledge.
Annual Fund multi-year Pledges
When posting multi-year pledges for donors other than graduating seniors , you will enter the following to be sure they are excluded from monthly cash flow reports for the Business Office
· Select the Attributes tab, enter the Category: Gift Attribute, Special Gift Code, Description: Multi-year Pledge.
Annual Fund Online Recurring Gifts
When posting online recurring gifts, you will enter the following to be sure they are excluded from various reports.
· From the gift tab, enter the pledge as normal with the schedule of payments except un-select the “send reminders” box.
· [bookmark: _4kgjeak4lvug]Select the Attributes tab, enter the Category: Gift Attribute, Special Gift Code, Description: Recurring Gift.
Stock Gifts (All Funds)
· Upon notification of a stock gift, open the donor constituent record in Raiser’s Edge.
· From the Gifts tab, select New Gift. (If gift should be applied to a pledge, select “yes” on the question pop-up.
· Enter Gift Type button: Stock/Property
· Enter the Value determined in step 4 of the Gift Receiving section (p. 8)
· On the Acknowledge button: enter “Acknowledged” (will need to create a manual letter)
· Issuer button: Enter brokerage firm name
· Details button:
-Enter the stock symbol from statement
-Enter no. of units: # of shares sold
-Enter on Median Price per unit the donor value of the gift.

· Upon receiving the actual stock check from the brokerage firm:
· Open constituent record and go to the “Gifts” tab
· Double click on the stock gift
· From the menu bar, click on Gift then Sell Stock Property
· Sale Amount: enter the principal amount (listed on statement)
· Broker Fee: enter all fees charged to SCDS by the broker (listed on statement)
· Press the Okay button on the lower left
· Gift Date button: enter date that check is posted
· Acknowledge button: enter “Acknowledged” (You will generate an acknowledgment letter manually based on what fund gift is applied to unless you have already done so upon notification)
· Pay Method button: Business check
· Check no./date button: enter information
· Save and close the gift
Employee Payroll Deductions Monthly Batch Entry
You will receive a list of these each month from the Business Office.
Open the Batch module in Re
· Select Batch #500
· Click on the ‘Date’ column in the green row
· Select the ‘Tools’ button and ‘Global change Date’ to current month
· For Value: Enter a date (I like to select a date that no other posting is taking place so that I can easily run a separate report of these postings. A weekend date is okay to use).
· When pop-up appears, click the box to overwrite existing value.
· Repeat the two steps above in the ‘GL Post Date’ column in the row highlighted in green.
· Review line by line and compare to report from Business Office and update as needed.
· [bookmark: _n0n90r1y4msw]After completing updates and confirming total, Select “!” to process batch entry
Annual Fund Gifts
Check, Cash, Credit Card, Matching Gift, Stock Gift, Written Pledge
Be sure and add any appeal that is on the Appeal tab of the Constituent Record.
· Be sure and enter the current year Campaign
· Enter gift sub-type if applicable (example: online donation, pledge, etc)
· Enter the following fields.
· For acknowledgment letter information, see ack letter grid on page ?????

add Screenshot Here

Annual Fund Gifts on behalf of another individual
Check, Cash, Credit Card, Matching Gift, Stock Gift, Written Pledge
· Be sure and enter the current year Campaign.
· Enter gift sub-type if applicable (example: online donation, pledge, etc)
· Enter the following fields.
· For acknowledgment letter information, see ack letter grid on page ?????

add Screenshot Here

Matching Gifts
Check, Credit Card, Matching stock gift, Matching Gift Pledge
· Enter the MG pledge on the Donor record, Upon posting a pop-up box will appear and ask if you want to apply to a pledge – choose Yes.
· Highlight the appropriate employee name for the matching gift and click Okay
· Add posting information
Restricted Gifts
Any restricted gift must be approved by the Director of Advancement prior to processing.

Box Tops for Education:
The Development Office should track future donations from Box Tops in order to thank them properly as well as
· The Advancement Office should track donations from Box Tops for Education as restricted gifts to Lower School GL Code 2-4200-100.
· An email should be sent to Lower School to advise them of the amoun

Check, Cash Credit Card, Credit Card, Matching Gift, Stock Gift, Written Pledge
Booster Club:[image: Macintosh HD:Users:henry:Desktop:Booster gift RFF.png]
· GL Code to post gift to: 1-4940-815
· Fill out a Request for Funds form as follows:
· Notify the Booster Club President & Treasurer of the donation.



Arts Alliance:
· GL Code to post gift to: 1-4940-825[image: Macintosh HD:Users:henry:Desktop:Arts Alliance gift RFF.png]
· Fill out a Request for Funds form as follows:
· Notify the Arts Alliance President & Treasurer of the donation. (2016-17 Pres is Susan Huennekens)
· Make 3 copies form and check. Original Check & copy of both to Brenda Cobb. Original form & copy of both to Vondean Williams,  Copy of both for Dana Meyer.
· 
Capital Campaign Gifts
· Add info here

Check, Cash Credit Card, Credit Card, Matching Gift, Stock Gift, Written Pledge
· Enter the add details here

Horizons Gifts
Check, Cash, Credit Card, Matching Gift, Stock Gift, Written Pledge
· Only post gift
· “Do Not Acknowledge”
Calendar Year End
· During the Holiday Break a sign needs to be printed out and brought to the SCDS guard reminding them to accept the mail each day and unlock Triol Hall for the Postal delivery if necessary.
· The mail is sorted either by David Ratcliff, Triol or Advancement Office staff members. 
· During the break, the Advancement Office will periodically post all gift receipts with the proper GL codes.  All original checks will go to Brenda Cobb to post in the General Ledger.  Copies of any non-annual fund checks to be given to Emily Foley to post in Access for balancing purposes.  Everyone should double check mail placed in boxes for Mary Hagan, Brenda Cobb, Becky Cheatham, Sonja Henry, or Brooke Fuller to be sure the Advancement office processes all gifts.
· Checks and credit card gifts that are received with a date of December 31 or prior will be posted as such in both the Advancement Raiser’s Edge software and the Business Office General Ledger. The Cash or Credit card deposit totals will be posted in the GL and Credit card cash columns on the December Excel bank reconciliation sheet.  All Online Credit card receipts will be dated in the same calendar year that Authorize.net posts them.  If the Authorize.net Date/Time on the transmittal is after December 31, spreadsheet reports and posting will take place in January after final hard close of December is complete.
· Horizons Donations: Christy Edwards will periodically provide the Business & Advancement Offices with gifts that are to be posted with a December date in both the Advancement Raiser’s Edge software and the Business Office General Ledger (as long as they are dated on or prior to December 31.  Christy will scan check copies to Sonja, and make copies for Emily and Brenda. During the holidays, original checks given are directly to Brenda Cobb. Checks and credit card gifts that are received with a date of December 31 or prior will be posted as such All Online Credit card receipts will be dated in the same calendar year that Authorize.net posts them.  If the Authorize.net Date/Time on the transmittal is after December 31, spreadsheet reports and posting will take place in January after final hard close of December is complete.
· NO JANUARY GIFTS WILL BE POSTED BY ANY DEPARTMENT UNTIL Advancement office has determined there are no other December checks (near Jan. 15).  At that point in time the Advancement office will run their end of month reports and balance with Emily Foley.  Then cash flows will be submitted by Advancement to Tim Kiene to post the FASB adjustments. Until then all January gift receipts must be held.
· During the break (12/31) the Business office soft closes by balancing the month for the student billing Accounts receivable balances and deposits as well as Accounts payable disbursements. The fiscal period of December will not be finally closed out until the Advancement office has insured that all December checks are posted.  Budget reports are run after the final December close.
Fiscal Year End

Per email from Tim Kiene 6.29.2015

The Finance Department will receive checks in BB on the date they are actually received. This means that a check that comes in dated July 3, will be a July receipt for financial purposes; impacting cash and income in July.

Where appropriate, Advancement will record the check in the year intended by the donor.  The purpose for this is to assure the donor gets credit on the intended year annual report for the gift and Advancement can solicit more funds in the year the cash is received.

If AF gifts are received after June 30 but the donor wants it recognized as a prior year contribution, there will be a discrepancy between the records that Advancement shows on the Annual Report and what Finance shows on the audited financial statements.
Retention of Postings
· Digitally file in Google Drive shared folder: Posting/Balancing > 2016-17 Postings > ETC.



[bookmark: _3as4poj]
Acknowledgment Letter Processing
Generate Acknowledgment Letters from Raiser’s Edge

After gifts have been posted to reflect a specific letter, you will then be able to generate letters automatically from the Raiser’s Edge Mail Module. Refer to the next section for details on how to add a new letter.

Open the Mail Module
ALWAYS run the Annual Giving HS first.
Open Annual Giving HS
From the top menu bar select Send to Word merge wizard.
Select Finish
When prompted, do not Acknowledge Letters
Upon Confirm File Location, the string name will reflect 1120$, add \henry
Copy and paste into MS Word
Proof and tweak letters from posting details

Open the Annual Giving DA
From the top menu bar select Send to Word merge wizard.
Select Finish
When prompted, save static query as ENV
When prompted, YES, DO Acknowledge Letters
Upon Confirm File Location, the string name will reflect 1120$, add \henry
Copy and paste into MS Word
Proof and tweak letters from posting details
Run the query to get data for the envelopes

**To un-acknowledge, go to Query. Select “acknowledged” in Postings folder. Change to today’s date. Save and close. Then go to Admin, Global Change. Under “Gifts”, select unacknowledge.  Run.  
Add a New Acknowledgment Letter to Raiser’s Edge

Create your letter in Microsoft Word.
Note: This step is optional but will simplify the process since you will be able to copy and paste your letter(s) from MS Word into RE rather than creating a new document directly in RE.  Merge fields should not be added yet.
[image: ]

Open Raiser’s Edge/Config/Letters/Gift
· Select the New Letter button
· Enter Letter Description (i.e. Tedder Memorial)
· Press Save & Close button.








[image: ]



Open the Constituent Record of the donor to be acknowledged.
· From the [Gifts] tab, open the gift that is “Not Acknowledged”. 
· Add the letter name from the drop-down menu into the Letter Field.





[image: ]

Open the Mail Module/Donor Ack Letters
· Select the New button (unless you already have letters configured that meet the criteria).
· From the [1. General] tab, you have the option to select specific dates of unacknowledged letters or specific records if desired.





· From the [2. Fields to Include] tab, you will need to add any merge fields that will be included in any of the letters that will be in this mail merge group name.[image: ]
· You also MUST include Gifts Letter in order to specify each letter for RE to merge.




[bookmark: _147n2zr]
[image: ]

· From the [3. Filters] tab, you may select specific funds to include in the mail merge.



















· Under the Letters filter option; you will select any letters that to be included in the mail merge, including the one you are creating.





· Select the ‘Send to Word merge wizard’ button.[image: ]
· Select the Next button.
















[image: ]


· You may choose to ‘Acknowledge’ the letters here by clicking the ‘Yes’ button.










[image: ]
· If you are using more than one letter in your mail merge file name, you will select the second choice. If you select the first choice, you will not have the option of entering multiple letters.
· Select the Next button.











[image: ]
· For the conditional field, you will select ‘Letter’.
· Select the Next button.














[image: ]




· This is where you will add your letter(s).
· Select ‘New Document’.


[image: ]
Endowment
Incomplete


Communications Support
You will need to extract data from Raiser’s Edge for various needs of the Communications Department.  This section is a How-To for various data requested by that department for mailings, graduation data, etc.
List of Grads with Parent or Grandparent Alums/Class Associates
Each year photographs are taken of graduates who have parents or grandparents who are also SCDS Alums or Class Associates. Follow these instructions to ensure you are giving accurate data.

· Open the Raiser’s Edge Query Module and the query: “Graduating Seniors with AL or CP Parents or GP”
Update the Primary Education in the criteria to reflect the current year.
Run the query
· Open the Export Module and the export: “Graduating Class Export”
Include the above query and export the data
Clean up the data and pass it on to the Communications Dept.

Mailings

Images
Incomplete

Annual Report
Incomplete

Hornet Connection
Incomplete

[bookmark: _19c6y18]
Annual Fund Campaign
This section should be updated by the Director of Annual Giving
Calendar
Incomplete
Summer Tasks
· VOLUNTEER ORGANIZATION – main item on your list for the summer!

· June 30 Fiscal Year End Annual Report exports

· Re-order business reply envelopes and/or Annual Fund Pledge Card make changes as necessary

· Annual Fund Brochure should be printed and ready to go by early August – to pass out at the Opening Faculty Meeting and for mailings

· Revision of verbiage for brochures and solicitation letters
a. Headmasters Council  - Mills letter enclosed with brochure
b. Parent brochure - Mills
c. Past Parent brochure -  
d. Grandparent brochure – Pam McCaslin
e. Alumni brochure – George Barrow
f. New Parents – Lee McGee
g. Faculty & Staff – Leigh Beauchamp
h. Financial Aid – Terri Barfield

· Re-order car decals/bumper stickers for new fiscal year Annual Fund

· Create Solicitation mail lists by constituent

·  Matching Gift Online through HEP/CASE (covered through July) – do we want to continue?  Follow up with HEP re: invoice.

· Reinstate Headmaster’s Table meetings (last held in 08-09): get meeting dates (at differing times of the day) from Marcia/Lisa for Headmaster’s Table meetings with new parents in August/September.

· New Parent Ranking (1-4) – you will receive a notebook from Terri that has notes on those that have capacity to give or not

· Faculty & Staff Campaign – Leigh Beauchamp (F&S Liaison) announce at Opening Meeting Tuesday, August 13 9:30 a.m. and have handouts on every seat or include in the packet that Lisa puts together!

· Parents’ Nights – make sure Division Heads know that Mills Fleming will announce Annual Fund – go through Kef/Lisa and coordinate with Mills on presentation.  
i. Upper School – Tuesday, Aug. 29 p.m.
j. Pk – 5  - Tuesday, Sept. 10 6:30 p.m.
k. Middle School  - Thursday, Sept. 12 p.m.

· Thousand Thanks Event – set date for this donor appreciation event (September?) for Annual Fund donors over $1,000+ hosted by Dev. Committee member?

· NAIS Statistic Report for Tim Kiene (See NAIS Statistics folder; reference Annual Fund Weekly Analysis Reports)
Solicitation Hierarchy
In the Annual Fund campaign at SCDS, many of our constituents fall into a variety of categories.  Careful planning and organization of solicitor assignments is important to our donor relations program, as it helps to maximize an individual’s giving (based upon volunteer support for various constituencies and previous gifts) as well as ensures that people are not being asked several times by various volunteers.  All members of each category are solicited via letters and direct mail.  However, volunteers making face-to-face or telephone asks only support certain constituencies.  Below is a breakdown of the various constituencies to consider:

Trustees:  solicited by fellow Trustees (Annual Fund Chair on Board and Board Chair), regardless of previous Annual Fund gift.

Headmaster’s Council Prospects:  determined by previous year’s gift to the Annual Fund (two subgroups:  Headmaster’s Council $1,000+ and Trustees’ Council $500+) and solicited by members of the Headmaster’s Council Committee for the Annual Fund.

Faculty/Staff:  solicited by Leigh Beauchamp (faculty/staff liaison) at opening F&S meeting prior to the start of school.  

Current Parents:  solicited by volunteers on the Parent Committee for the Annual Fund.  Historically, parents with multiple children at SCDS are solicited by volunteers in their youngest child’s grade. The rationale follows the same format utilized by Pace Academy and other schools in order to ensure parents are not solicited three times, should they have three children.  Feedback has been that parents traditionally know parents in their eldest child’s class better than their youngest child’s class; however, at SCDS, we have had more difficulty in recruiting Upper School callers than Lower School callers.   

New Parents:  after feedback from previous years, parents new to SCDS are solicited separately from returning SCDS parents.  The start of the new parent campaign and their timeline is deferred in order to give them time to acclimate and realize the benefits of the SCDS experience.

Alumni: solicited by volunteers for the Alumni Campaign of the Annual Fund.

Past Parents:  solicited by letters and other direct mail pieces. Led by Past Parent Chair.

Grandparent:  solicited by letters and other direct mail pieces. Led by Grandparent Chair. No dedicated volunteers, but the 2009-10 Grandparent Chair did make a few phone calls to encourage some grandparents with major gift potential and also wrote personal notes on letters prior to mailing.

New Grandparent:  solicited by letters and other direct mail pieces.  No dedicated volunteers, but the 2009-10 Grandparent Chair did make a few phone calls to encourage some grandparents with major gift potential and also wrote personal notes on letters prior to mailing.

FOUR EXAMPLES:  
Constituent who is both current parent and alum is solicited as a current parent.
Constituent who is faculty/staff, current parent, and alum is solicited as a faculty/staff member.
Constituent who is alum and gave $750 to previous year’s Annual Fund is solicited as a Headmaster’s Council Prospect.
Constituent who is both new parent and alum is solicited as a new parent.
Solicitation Recommendations
Fall
	Headmaster’s Council Prospects – August
1. Ask for same amount
1. Ask to join Headmaster’s Council – no ask amount
2. Increase giving < $1,000
3. Increase giving > $1,000
4. Matching gift
5. Personal visit: $2,500+

Headmaster’s Council Prospects—December: follow-up year end letter

Current Parents—September
1. Ask for same amount
2. No ask amount
3. Ask for increased amount

New Parents—October
1. Headmaster’s Council Ask
2. No ask amount

Alumni—September/October
1. Reunion Years – September 
2. Young Alumni – October 
3. Regular Alumni – October
4. Pape – October

Parents of Alumni (aka Past Parent)—September 

Grandparent/New Grandparent—September 

Spring
January
1. New Annual Fund donors (include update on campaign)
2. Donors with increased gifts/pledges (include update on campaign)
3. Return donors to the Annual Fund (include update on campaign)
4. Volunteer “thank you” (include update on campaign)
5. New Parent Second Appeal
6. Current Parent Second Appeal (from Grade Chair)

February: focus on participation
1. Parent letter (enclose update with participation breakdown by class)
2. New Parent letter (enclose update with participation breakdown by class)
3. Alumni letter (enclose update with participation breakdown by class)
4. LYBUNT (less Headmaster’s Council)
5. SYBUNT (less Headmaster’s Council)
6. Headmaster’s Council Third Appeal


May
1.  Lybunt—Final Appeal
2.  Sybunt—Final Appeal

BEFORE ANY MAILING, ALWAYS REMOVE DONORS CODED AS “DO NOT SOLICIT” (UNDER ATTRIBUTES/MAIL CODES), DECEASED OR THOSE THAT HAVE DECLINED!
Volunteers
Job Descriptions
Dev/Annual Fund/AF 09-10/Volunteer Leadership/Job Descriptions.  
Training Manual Information
Dev/Annual Fund/AF 09-10/Volunteer Leadership/Notebooks.  Customize for individual volunteer with job description and update for 2010-11 school year; also, include confidentiality agreement located in Dev/Annual Fund/AF10-11/Volunteer Leadership/Training Manual Notebooks/Confidentiality/Sample Confidentiality Agreement.
Signature Form
Dev/Annual Fund/AF 10-11/Volunteer Leadership/Signatures/Signature Form.  Have a scanned copy on file for volunteers who will be signing letters.
Confidentiality Agreement
Per Board Chair Wade Herring and Director of IT, this is to be signed by any volunteer who will be privy to confidential information.  Located Dev/Annual Fund/AF10-11/Volunteer Leadership/Training Manual Notebooks/Confidentiality/Sample Confidentiality Agreement.
Code Volunteers/Solicitors in Raiser’s Edge
The purpose of coding volunteers in Raiser’s Edge is the tack the moved of volunteers throughout the campaign and to pull queries and reports based on this constituent attribute.
[image: ]
Code Solicitor
“Attributes” tab:  Category = Volunteer Codes. Description = AF Volunteer Committee. Date = enter start date (e.g., 7/1/2012). Comments = volunteer position (e.g., 7th Grade Caller).  See sample.
	
	

Ensure volunteers are coded as solicitors on the “Bio 1” tab:  check the box next to “solicitor.”  See sample.











Assign Solicitors to Prospects in Raiser’s Edge

Open the “Relationships” tab on the donor prospect’s record:  Select “Assigned Solicitors” from column at left.  Select  "New Assigned Solicitor” from tab at top.  Use binoculars to search for solicitor. Select the Solicitor.  Solicitor type = Annual Fund Volunteer.  Date from = enter start date, (e.g., 7/1/2014). Date to = enter end date (e.g., 6/30/2015).Campaign: select from drop-down box (e.g, AF14-15). Fund = Annual Fund.  Do not enter appeal here, as appeals are entered when gift/pledge is received in writing.  See sample below:  Prospect = Ronald Fagin; Solicitor = Pam McCaslin.
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[bookmark: _3cqmetx]

Add Verbal Pledge to Raiser’s Edge

Enter a verbal pledge to ensure ability to track undocumented pledges and generate pledge reminders.  Note:  given that these commitments are verbal (ie: nothing in writing to substantiate commitment), such intentions are not formally included on the Gifts tab.
· Open the Constituent record
· Assign the solicitor (Refer to above instructions)
· Select the Appeals tab:
· Enter Appeal (e.g., Annual Fund 2012-13 or AF13-14 Phonathon)
· Enter Date: date solicitor held conversation with prospect (otherwise, it will default to current day)
· Enter Response: Verbal Pledge/Unspecified Amount/Considering/Declined and enter gift amount, if donor has provided 
· Enter Comments: enter amount and any pertinent notes (e.g., how information obtained).  There are many fields here, but these are the only fields used—tab to scroll to the right.  During gift entry, staff member will need to ensure that there is no pending verbal pledge appeal.  If there is, then the gift will be credited to that appeal and the “total given” field will be updated automatically.

See sample below: Prospect = William J. Hunter.

Tab to scroll to the right; there are many fields, but the ones mentioned above and in samples below are used for queries/reports.  




Prospect codes in Raiser’s Edge
Under the PROSPECT tab in an individual's record, the CLASSIFICATION and PROSPECT STATUS​ choices are as follows:

Constituent Classification options
A1
A2
A3
B1
B2 
B3
C1
C2
C3

Constituent Prospect Status options
Identification/Research
Cultivation
Solicitation
Closing
Stewardship

Code a Constituent as “Do Not Solicit” in Raiser’s Edge
· Under “Attributes,” Category=Mail Codes, Description=Do Not Solicit, Enter date and add any comments.  Remember to consult with Senior Admin/HR and consider anyone who was involuntarily terminated for Do Not Solicit status.  Also, remove anyone who does not wish to be solicited prior to a mailing.
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Pledge Reminders from Raiser’s Edge
Report
· Open the Reports Module, Pledge & Recurring Gift Reports, Past Due Report, DAG AF Current & Past Due Pledges. 
· From the Generals tab, be sure the settings are for the current FY and create GIFT output query is selected.
· Preview and print the report.
Reminders
· Open the Mail Module, Reminders, DAG AF Pledge Reminders
· Start should be July 1 of the current fiscal year and End should be the 2nd day of the month that reminders are due. For example: If you are sending Reminders that are due 12/1/2014, the End Date should be 12/2/2014.[image: ]
· Run Dates should also be 12/2/2014.
· Press the “Send to Word merge wizard” button.
· I suggest that you export prior to printing since settings are not accurate in Re for this.  To do this, select the Export icon at the top.
· Export in .pdf format
· Download the export from the hosted server and print onto the three-part Annual Fund Reminder forms (through the bypass of the printer.)

Annual Fund Solicitation Lists from Raiser’s Edge
Adding Group Appeal Codes
· Purpose – import appeal or package codes for a group on an external spreadsheet (mailing list).  
· Steps:
1. Create spreadsheet from the mailing list with the following fields: ImportID (for constituent), CAPAppealID (Appeal name), CAPPackageID (package name), CAPDATE (mail date)
2. Save in CSV format
3. Log in to RaisersEdge as the supervisor in order to access the Admin tab
4. Choose “Import”
5. Under “Constituent Appeal”, Select existing “Appeal Import” created on 11/23/15
6. General Tab - If you are creating a new appeal for each constituent, choose “Update existing records” and select the spreadsheet to import (file type “csv”). Use the Import ID to identify constituents.
7. File Layout – All options should remain as they are. Check the sample import format at the bottom.
8. Fields – map each field to import. Should match the headers on your file.
9. Summary – check each import option box and name an exception file.  
10. Then Update Now.
**** We recommend testing a file of one or two records first before importing the entire mail list.
Adding Group Package Codes
· Purpose – import appeal or package codes for a group on an external spreadsheet (mailing list).  
· Steps:
1. Create spreadsheet from the mailing list with the following fields: ImportID (for constituent),  CAPPackageID (package name), CAPDATE (mail date) and CAPAppealID (Appeal name),
2. Save in CSV format and follow instructions above

Parents
· To determine number of parents per class and per section for reporting purposes, create the following queries for each class year:

Example:
Create the following 3 dynamic queries.
1. Original dynamic query:  DAG [class]
Includes: Const. Code one of CP, NP AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son & Relationship Education Class of equals 2028.
2. Original dynamic query:  DAG [class] Parents with Withdrawn Children
Includes: Const. Code one of CP, NP AND (Individual Relationship Constituent Code equals Withdrawn Student AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son AND Relationship Education Class of equals 2028)
3. Query: DAG Head of Household
Includes: All records in Raiser’s Edge that are coded as ‘Head of Household
From your 3 dynamic queries, you will create the following static queries.
Merge query 1 & 2 above using the 'SUB' operator to create a new query.
4. New Merged query:  DAG [class] Parents less withdrawn
Merge query 4 with query 3 using the 'AND' operator to create the final query.
Final Merged Query:  DAG [class] PCQ HOH

· To create a query of all current and new parents, run a Constituency Query and ensure Constituency Description is “one of Current Parent, New Parent, Little School Parent” Name this query, e.g., Current, New, & Little School Parents.
· Merge queries Current, New, & Little School Parents with Do not Solicit using the ‘SUB’ operator. Name this query, e.g., Parents 2015-16 less DNS.
· Merge queries Parents 2015-16 less DNS with DAG Head of Household using the ‘AND’ operator. Name this query, e.g., DAG Parents 2015-16 HOH.  This will be the standard query used for monthly analysis to evaluate giving of all parents.  See Google Drive/Annual Giving Campaign/15-16/Analysis 
· Do the same as steps above to create query of Grandparents, Past Parents, Alumni/Class Associates

· To generate parent solicitation lists for 2013-14 volunteers and phonathons: Begin with DAG**** HOH and subtract Headmaster’s Council, New Parents, and Faculty/Staff and all who have given to the AF so far (create a query from DAG 2013-14 AF Gifts Total. Perform these steps for all class years (PK-12th) and assign individuals to Parent Committee.

Historically, parents with multiple children at SCDS are solicited by volunteers in their youngest child’s grade. The rationale follows the same format utilized by Pace Academy and other schools in order to ensure parents are not solicited three times, should they have three children. Feedback has been that parents traditionally know parents in their eldest child’s class better than their youngest child’s class; however, at SCDS, we have had more difficulty in recruiting Upper School callers than Lower School callers. This is a manual process, most easily determined from an export of all parents. To do so, create a Current & New Parent 2013-14 HOH query and run DAG Youngest child Export to obtain this information. Be sure to export the Class year for alum parents.

Grandparents
· Generate grandparent queries for 2013-14:  To create a query of all current and new grandparents, run Constituency Query and ensure Constituency Description is “one of Grandparent, New Grandparent.”  Name this query, e.g., “DAG Grandparent 2013-14”. Merge with “Do Not Solicit” using the “sub” operator. Name this query, e.g., DAG Grandparent 2013-14 less DNS”. Merge this query with DAG Head of Household using the “and” operator. Name this query, e.g., DAG GP & NG 2013-14 HOH.”  This will be the standard query used for weekly/monthly analysis to evaluate giving of all grandparents.  See Dev/Annual Fund/AF 13-14/Analysis/Monthly Analysis.
· Do the same as steps above to create query of new grandparents, run Constituency Query and ensure Constituency Description is “one of New Grandparent.”  Name this query, e.g., “DAG New Grandparent 2013-14”. Merge with “Do Not Solicit” using the “sub” operator. Name this query, e.g., “DG New Grandparent 2013-14 less DNS”. Merge it with DAG Head of Household using the “and operator. Name this final query “DAG NG 2013-14 HOH.”  This will be the standard query used for weekly/monthly analysis to evaluate giving of only new grandparents.  See Dev/Annual Fund/AF 13-14/Analysis/Monthly Analysis.

Alumni & Class Associates
To create a query of all parents of alumni, run Constituency Query and ensure Constituency

Parents of Alumni (aka past parent)
· To create a query of all parents of alumni, run Constituency Query and ensure Constituency Description is “one of Past Parent.”  Name this query, e.g., “DAG Past Parent 2013-14”. Merge this query with “Do Not Solicit” using the “sub” operator. Name this query, e.g., “DAG Past Parent 2013-14”.  Merge it with DAG Head of Household; name this query, e.g., “DAG PP 2013-14 HOH.”  This will be the standard query used for weekly/monthly analysis to evaluate giving of all parents of alumni.  See Dev/Annual Fund/AF 13-14/Analysis/Monthly Analysis.

Headmaster’s Council
· Code Headmaster’s Council prospects for 2013-14:  Run a report of any donor who contributed $500-$999 and globally DAG the following code:  
· Individuals coded as Headmaster’s Council prospects include anyone who donated $500-$999 (Trustees Council) or $1,000+ (Headmaster’s Council) to the Annual Fund.   Both subgroups have been analyzed individually as well as the whole.  Codes are noted on the donor file under “Attributes,” Category = Annual Fund Prospect, HC 2013-14 ($500-$999)/HC 2013-14 ($1,000+). 
· To determine the individuals for whom codes are needed, run a report of all donors who made total gifts to the Annual Fund between $500-$999 and globally add the following code:  HC 2013-14 ($500-$999) to the Attribute tab.  Run a report of all donors who made total gifts to the Annual Fund exceeding $1,000+ and globally add the following code:  HC 2013-14 $1,000+.  Finally, run a query that contains both groups and name, e.g., DAG HC Prospects 2013-14 (Attribute) so that you can look at all prospects in their entirety.
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Annual Fund Monthly Analysis
This report is generated each month or as needed for the Director of Advancement, Advancement Committee Meetings, Annual Fund Chair(s), Director of Alumni, Head of School Assistant (for Board of Trustees meetings). Below is a list of the standard queries used for the various reports.  For the analysis spreadsheet, open Google Drive/Advancement Shared Folder/Annual Giving Campaign/16-17/Analysis.

Queries for The Fund Analysis
· Trustees 2017-18 Analysis: _27_(Includes non-voting Trustees
· Generate a constituent query of: Constituent Code equals Trustee
· G&G Soc 2017-18 Analysis:  Gold Society donors 2,500+ 
· Generate a constituent query of:
	Gift Amount Greater than or equal to $2,500
	And Campaign Description equals Annual Fund 17-18
Open Tools from the top menu, select Query Options:
Record Processing tab & choose query: DAG Head of Household
Gift Processing tab & select: Credit Soft Credits to Both & Credit Matching Gifts to Donor
· Trusdell Cir 2017-18 Analysis: Trusdell Circle donors between $1,000-$2,499
· Generate a constituent query of:
Gift Amount between $999.00 AND $2,499.00
AND Campaign Description equals Annual Fund 2017-18
Open Tools from the top menu, select Query Options:
Record Processing tab & choose query: DAG Head of Household
Gift Processing tab & select: Credit Soft Credits to Both & Credit Matching Gifts to Donor
· Crest Cir 2017-18 Analysis: Crest Circle donors between $500-$999
· Generate a constituent query of:
Gift Amount between $499.00 & $999
AND Campaign Description equals Annual Fund 2017-18
Open Tools from the top menu, select Query Options:
Record Processing tab & choose query: DAG Head of Household
Gift Processing tab & select: Credit Soft Credits to Both & Credit Matching Gifts to Donor
· Parents 2017-18 Analysis: _653_(Used ONLY to determine # of parents)
[bookmark: _GoBack]**See Instructions under Annual Fund Detail Reports section below.
· Grandparents 2017-18 Analysis: _781_(Used ONLY to determine total # of Grandparents)
· Generate a constituency query of:
Constituency code one of Grandparent, New Grandparent
**AND Solicit Code Description not one of Do Not Contact, Do Not Solicit
**AND Inactive? equals No
Tools > Query Options > Select from my query: DAG Head of Household
· Export the query to get the correct final #
· After exporting, edit query and remove ** parameters
· Past Parents 2017-18 Analysis: _1,205_(Used ONLY to determine # of past parents)
· Generate a constituency query of:
Constituency code equals Past Parent
**AND Solicit Code Description not one of Do Not Contact, Do Not Solicit
**AND Inactive? equals No
Tools > Query Options > Select from my query: DAG Head of Household
· Export the query to get the correct final #
· After exporting, edit query and remove ** parameters
· AL & CA 2017-18 Analysis (Donor #): _3,694_(Used ONLY to determine # of Alumni/Class Associates)
· Generate a constituent query of:
Constituent Code one of Alumni, Class Associate, Pape, Pape AL, Pape CA
**AND Solicit Code Description not one of Do Not Contact, Do Not Solicit
Tools > Query Options > Select from my query: DAG Head of Household
· Export the query to get the correct final #
· After exporting, edit query and remove ** parameters
· AL & CA 2017-18 Analysis ($$$ )(Used ONLY to determine $$$ of Giving)
· Generate a constituent query of:
Constituent Code one of Alumni, Class Associate, Pape, Pape AL, Pape CA
Analysis Spreadsheet Report
For the analysis spreadsheet, open Google Drive/Advancement Shared Folder/Annual Giving Campaign/17-18/Analysis.
· Open the most recent dated excel spreadsheet
· Change date in header to the current date, then click on “File” “Save As” rename the document the current date (i.e. 11.7.17)
· Open the Raiser’s Edge Reports Module, Financial Reports, Gift Detail and Summary Reports/Select report as indicated below.
· Note: The reports below in Green Italic are set at the beginning of each fiscal year and should not need modification before running for each Analysis throughout the fiscal year.

1. Overall Total Giving
Select report 2017-18 Overall Total Participation
Parameters below:
General tab:
Include All Records
Soft Credit Gifts To  Donor
Credit Matching Gifts To  MG Company
Report Type:  Summary
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Constituent Codes: Include All
Format tab:
Title: The Fund For Country Day
Subtitle: current FY Overall Participation

2. Board of Trustees Participation
Select report 2017-18 BOT Participation
Parameters below:
General tab:
Include Trustees 2017-18 Analysis
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Constituent Codes: Trustee
Format tab:
Title: The Fund for Country Day
Subtitle: 2017-18 Board of Trustees Participation

3. Faculty & Staff Participation
This information can be obtained from the Director of Annual Giving.
	Update

4. Green & Gold Society ($2,500+ & Young Alum Leadership)
Select report 2017-18 Green & Gold Society
Parameters below:
General tab:
Include G&G 2017-18 Analysis
Soft Credit Gifts To  Both/Use distribution on gift
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Format tab:
Title: The Fund for Country Day
Subtitle: 2017-18 Green & Gold Society

5. Trusdell Circle ($1,000-$2,499)
Select report 2017-18 Trusdell Circle
Parameters below:
General tab:
Include Trusdell 2017-18 Analysis
Soft Credit Gifts To  Both/Use distribution on gift
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Format tab:
Title: The Fund for Country Day
Subtitle: 2017-18 Trusdell Circle

6. Crest Circle ($500-$999)
Select report 2017-18 Crest Circle
Parameters below:
General tab:
Include Crest 2017-18 Analysis
Soft Credit Gifts To  Both/Use distribution on gift
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Format tab:
Title: The Fund for Country Day
Subtitle: 2015-16 Crest Circle

7. Parent Participation (Includes Current, New & Little School Parents)
Select report 2017-18 Parent Participation
Parameters below:
General tab:
Include Parents 2017-18 Analysis
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Format tab:
Title: The Fund for Country Day
Subtitle: Parent Participation

8. Grandparent Participation (Includes PK-12 Grandparents)
Select report 2017-18 Grandparent Participation
Parameters below:
General tab:
Include Grandparents 2017-18 Analysis
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Format tab:
Title: The Fund for Country Day
Subtitle: Grandparent Participation

9. Past Parent Participation (Parents of Alumni)
Select report 2015-16 Past Parent Participation
Parameters below:
General tab:
Include Past Parents 2017-18 Analysis
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Constituent Codes: Past Parent
Format tab:
Title: The Fund for Country Day
Subtitle: Past Parent Participation

10. Alumni Participation (includes Alumni & Class Associates)
To obtain the total number of donors, select report 2017-18 Alumni Participation (Donor #)
Parameters below:
General tab:
Include AL & CA 2017-18 Analysis (Donor #)
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Summary
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Constituent Codes: Alumni; Class Associate
Format tab:
Title: The Fund for Country Day
Subtitle: Alumni/Class Associate Participation
To obtain the total dollar amount, select report 2017-18 Alumni Participation ($$)
Parameters below:
General tab:
Include AL & CA 2017-18 Analysis ($$$)

Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Report Type:  Detail
Filters tab:
Campaigns: Include Selected: Annual Fund current fiscal year.
Constituent Codes: Alumni; Class Associate
Format tab:
Title: The Fund for Country Day
Subtitle: Alumni/Class Associate Participation
Annual Fund Detail Reports
Parent Class Analysis
 
Determine Class Numbers
Parent ‘Class Giving’ statistics are based of the number students per grade.  Open the Whipple Hill directory. From the Parent Portal, select Directories, Student. When you see Student Grades listed on the right side, select Show More and the view will show you the number of students per grade. This is the # to use per grade. It is a good idea to compare to Raiser’s Edge to be sure #’s match. For Little School, you will total the 1-4 year olds.

Export all of the student from BBK-12. After exporting, keep a main list of all:
Add sheets for each division (Little, Lower, Middle & Upper)
Sort by address to de-dup manually per level to determine the # for each level.
**Do the same process for the main list to determine the total # of parents
	Note: Be cognizant of the fact that there may be exchange students who share addresses
with current students and they should not be considered duplicates.

What about twins? It was determined that this can be revisited if percentages of giving per grades become high – over 75%.

Parent Unit: A Parent Unit includes both parents of a student. If the parents are divorced, they are considered one parent unit.
 
Reports
RE Reports\Financial Reports\Gift Detail & Summary Report\Parent Analysis by Class
        	Each year you will need to update the following:
Filters Tab: Campaigns: Include Selected: Annual Fund current fiscal year
Format Tab: Change heading to current fiscal year
 
Queries for Reports
Parent Class Queries
Query (Dynamic):  Parents - Class of <ask>
Criteria: Constituency Code one of Current Parent, New Parent, Little School Parent
AND Relation Const. code one of SCDS Student, Little School Student
AND Relations Education Class of <ask>
AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son
From the top menu bar select Tools, Query Options,
Record Processing, Select from query DAG Head of Household
Gift Processing, Credit Soft Credits to Both, Credit Matching Gifts to Donor
Note: All Little School students are lumped together and coded as Class of 1800.
 
School Section Queries
Little School Parents: See above
	
Query (Dynamic): *Parents – Lower School 17-18
Criteria:  Constituency Code one of Current Parent, New Parent
AND Relation Constituency Code equals SCDS Student
AND Relations Education Class of one of Lower School class years PK-5
AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son
From the top menu bar select Tools, Query Options,
Record Processing, Select from query R DAG Head of Household
Gift Processing, Credit Soft Credits to Both, Credit Matching Gifts to Donor
  	
Query (Dynamic): *Parents – Middle School 17-18
Criteria:  Constituency Code one of Current Parent, New Parent
AND Relation Constituency Code equals SCDS Student
AND Relations Education Class of one of Lower School class years 6-8
AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son
From the top menu bar select Tools, Query Options,
Record Processing, Select from query R DAG Head of Household
Gift Processing, Credit Soft Credits to Both, Credit Matching Gifts to Donor
 
  		Query (Dynamic): *Parents – Upper School 17-18
Criteria:  Constituency Code one of Current Parent, New Parent
AND Relation Constituency Code equals SCDS Student
AND Relations Education Class of one of Lower School class years 9-12
AND Individual Relation Relationship one of Daughter, Son, Step-daughter, Step-son
From the top menu bar select Tools, Query Options,
Record Processing, Select from query DAG Head of Household
Gift Processing, Credit Soft Credits to Both, Credit Matching Gifts to Donor					
 
Alumni & Class Associates Class Participation
Open the Reports Module in Raiser’s Edge, Financial Reports: DAG Annual Fund Constituency Report 2013-14.  Select the query named: DAG Class of **** and run reports based on each class year.
Soft-credit: Both/Matching Gift: Donor/Report Type: Gift Summary.
[bookmark: _319y80a]Run Summary Report.


Phone-a-thons
Solicitor/Phonathon Profile Sheet Template:  Dev/Annual Fund/AF 10-11/Phonathons.
Car Decals
Ordered through Florence (Minis) Slatinsky ’94 at Advertising Specialty Services.  Car decals are distributed after payment (of any amount) received in full or towards a pledge, but not upon pledge alone.  Sonja encloses with tax receipt and gift acknowledgement.  See hard copy files for samples and/or Dev/Annual Fund/AF 09-10/Campaign Appeal/AF Car Decals.  Order already complete and in stock for 2010-11 donors to promote support of the campaign.
Gifts for Volunteers
for the last three years, an engraved silver vase with logo and message has been ordered for the Annual Fund Chairs through Edyth Shadburn at Charles Willis in Atlanta.  Contact information:  edyth@charleswillis.com.  See hard copy files and/or shared files for copy of wording:  Dev /Annual Fund/AF 09-10/Volunteer Leadership/Volunteer Appreciation Luncheon/SCDS Engraved Pitcher.  

Additional gifts have been ordered for all volunteers and presented at the Volunteer Appreciation Luncheon in May.  These are small tokens and not meant to look as if money is being blown extravagantly, but rather as a means of acknowledgement and promotion of SCDS.  During 2009-10, green water bottles with SCDS logo were ordered through Florence (Minis) Slatinsky ’94 at Advertising Specialty Services.  Samples/extras are located in the Director of Advancement’s closet.
Green & Gold Dinner Invites
This includes donors of $2,500+ to ANY fund or campaign.
To pull this list:
	Raiser’s Edge Reports > Analytical Reports > DAG Green & Gold Society Members 2016-17
	Generals Tab
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Annual Audit Procedures
Reports
At Fiscal year end you will generate reports for auditors.
1. Cash Flow Reports
Before posting any pledge receivables for pledges to multi-year AF pledges and to other Capital Funds with pledges, General Cash Flow reports.
	Open the Raiser’s Edge Reports Module
· Select Pledge and Recurring Gift Reports, Cash Flow Report, Audit Cash Flow-Fund Name
· Changes should not need to be made to any of the tabs
· Preview each report
· Export each report as both a ‘.pdf’ and as a Microsoft Excel (97-2003) Data Only file (see below) to use for manipulation purposes.
[image: ]

· After exporting, save the .pdf reports in Google Drive for back-up. 
· Using the MS Excel versions, Create a MS Excel Document with separate tabs for each fund.
· Copy and paste the data into one report and manipulate to “clean-up” the exports.
Note: You may refer to samples of these in the Google Drive\Audit folder from previous year.
2. Gift Detail Reports
Open the Reports Module, select Financial Reports/Gift Detail & Summary Reports
…/Audit AF Gift Detail.
*General tab:
Include All records
Includes Gifts with these Dates (Last Fiscal Year)
Soft Credit Gifts To  Donor
Credit Matching Gifts To  MG Company
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
	*Format tab
		Heading Format: Change Subtitle to reflect last fiscal year.
Export each report as both a ‘.pdf’ and as a Microsoft Excel (97-2003) Data Only file (see below) to use for manipulation purposes. Combine all of these reports into one spreadsheet with a tab for each fund.

Follow steps above for all Funds:
…/Audit Endowment Gift Detail
…/Horizons Gift Detail
…/Audit Jenkins Annex Gift Detail
…/Audit NFC I Gift Detail
…/Audit NFC II Gift Detail
…/Audit Track Gift Detail

3. New Pledge Reports
Open the Raiser’s Edge Query Module
· Select Financial Reports, Gift Detail and Summary Report, Audit New Pledges Fund Name.  Be sure to create any new reports for new funds created during the fiscal year.
· On the 1: General tab, Change the dates to reflect prior fiscal year. Also change the date on the 8: Format tab.
· Preview each report
· Export each report as both a ‘.pdf’ and as a Microsoft Excel (97-2003) Data Only file (see below) to use for manipulation purposes.
· Follow steps above beginning with screenshot.

Email reports to Taylor Mongin Taylor.Mongin@hhbcpa.com
Confirmation Letters
Incomplete


Form 990 Schedule of Contributors
The CFO will request this information after the audit is complete (usually late August or early Sept.)

· Open the Raiser’s Edge Query Module
· Select the gift query: the query: Audit 990 Total FY Gifts $5,000+
· Highlight Filter and Select the CHANGE button
· From the pop-up box, select the FILTER tab
· Modify the “Gift Date between” to correct Fiscal Year for the audit
· Close the pop-up box and run the query.

· Open the Export Module 
· Select the export named Audit 990 Gift Information
· Update gift information to comply with FYE


Download and open the export


Manually add any Gifts-in-Kind with a $5,000 or above value.



Annual Report Proof

Annual Fund Proofs are sent to constituents via “Push Page” through Whipple Hill; Parents (just prior to end of school), Alums (early June), and Grandparents possibly in the future??? This report should not reflect unpaid pledges and serves two purposes: 1) Clarify names are listed properly; 2) A final appeal to those who have either not paid their pledge or not given to the Annual Fund.Add Alum Years Info

[bookmark: _3s49zyc]
Parent Proof
Open the Reports Module, select Financial Reports/Gift Detail & Summary Reports/
DAG AF Gifts Total current FY for Parent Proof
1. General tab:
Include DAG Head of Household
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
☑ Create  Constituent  output query
2. Filters tab:
Campaigns/Include Selected, Annual Fund current fiscal year.
Constituent Codes: Include Selected: Current Parent; New Parent; Little School Parent
Note: If new parents have been rolled a new for the next FY have been added, you will need to remove New Parent from the above.
3. Format tab:
	Title: current fiscal year Annual Fund Parent Proof
Select the Preview button
Print the report for two purposes 1) Back-up 2) Remove anonymous donor names from exported data.
Open the Export Module
Select: Annual Report Parent Proof Export
1. General tab:
Include the query created from the above report
2. Output tab:
Highlight Gifts
Select the Criteria button
Filters tab: Campaign should be updated to current Fiscal Year
Select the Export Now button & save the export in your local files.
Open the exported data, copy & paste into MS Word document “un-formatted”.
Remove anonymous donor names
[bookmark: _meukdy]
Alumni Proof
Open the Reports Module, select Analytical Reports/Alumni Class Analysis/Annual Report Alumni Analysis (SH)
1. General tab:
Include All Records
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
☑ Create  Constituent  output query
2. Filters tab:
Alumni Codes: Include Selected: Alumni; Class Associate; Pape
Campaigns/Include Selected, Annual Fund current fiscal year.
3. Gift Types tab:
All should be selected except for Pledge and MG Pledge
9. Format tab:
Title: Alumni Class Analysis
Subtitle: current Fiscal Year
Run Report and print for two reasons; 1) Back-up 2) Remove anonymous donor names from exported data.
Open the Export Module
Select: Annual Report Alum Export
1. General tab:
Include the query created from the above report
2. Output tab:
Highlight Gifts
Select the Criteria button
Filters tab: Campaign should be updated to current Fiscal Year
Select the Export Now button
After exporting, sort alpha
List AL/CA names only (not spouse unless also AL or CA)
List Married AL/CA together & delete duplicates
Place an asterisk “*” behind the name of “Class Associates”
Remove anonymous donor names from exported data and list as “Anonymous (# of anonymous)”
Copy and paste names in MS Word document “unformatted” add footer “* Denotes Class Associate”
Annual Report
The Annual Report data is exported by the Director of Annual Fund and assisted by the Advancement Office Assistant as needed.  It lists ALL DONORS except for those who wish to be anonymous. Cross check with other reports to ensure anonymous donor names are not listed. To confirm, run query Anonymous Donors (excludes AF) for all campaigns/funds other than AF.  For AF donors, run query Anonymous Donors (AF ONLY). Historically, Annual Report raw data is saved in Dev/Annual Report Data & Exports.  Once information is obtained, the information is copied into a MS Word document and the final versions saved for graphic designer to layout:  Dev/Publications/Annual Report FY.

Alpha Listing (Annual Fund)
Although we no longer list donors in our Annual Report in alpha order, this report will create a nice back-up list to refer to when questions arise.  From the Reports Module, select Financial Reports/Gift Detail & Summary Reports/ DAG Annual Report All Donors

1. Leadership & Volunteers (AF)
This information is provided by the Annual Giving Chair

2. Honor Roll of Donors (AF)
Open the Reports Module >Analytical Reports >Donor Category Report and select Annual Report Donor Category
1. General tab:
Include DAG Head of Household
[image: ]Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
2. Filters tab:
Campaigns/Include Selected, Annual Fund current fiscal year.
	3. Format tab:
     	Title: 2015-16 Annual Report
     	Subtitle: Donor Category Report
￫Select the Preview button
￫Export directly from the report preview as both a .pdf and as a Microsoft Excel (97-2003) Data-Only file.
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￫Open the exported data and compare to .pdf report and remove anonymous names.
￫Verify unpaid pledges and remove if necessary
￫Copy & paste into MS Word document “unformatted”.

Manually add Young Alum to Green & Gold Young Alum Society based on the groups below:
 
$500+           	10 to 15 years out from graduation
$250-$499      	5 to 9 years out from graduation
$100-$249      	Up to 4 years out from graduation $100
 
Example: For the 2017-18 year……….
…,The $500+ group would include AL & CA from classes 2008, 2007, 2006, 2005, 2004 & 2003.
…The $250-$499 group would include AL & CA from classes 2013, 2012, 2011, 2010 & 2009.
…The $100-$249 group would include AL & CA from classes 2017, 2016, 2015 & 2014.
 
Existing queries are named: 2017-18 G&G YAL 10 to 15 Years Out, 2017-18 G&G YAL 5 to 9 Years Out, and 2017-18 G&G YAL up to 4 Years Out.  You will need to update the class years and the Campaign.

3. Parent Support (Annual Fund)
Note: Parents who are divorced are counted as one family when calculating percentage of class giving.  However, they are not soft-credited for an ex-spouse gift unless instructed specifically by the donor to do so.  The # of parents should be determined with the help of the Annual Giving Director.
 
Open the Reports Module >Financial Reports >Gift Detail & Summary Reports and select Annual Report Parent Donors
1. General tab:
Include: Parents – Class of <ask>
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
2. Filters tab:
Campaigns/Include Selected, Annual Fund current fiscal year.
Constituent Codes/Include Selected, Little School Parent; Current Parent
3. Format tab:
Title: 2016-17 Annual Report
Subtitle: 2016-17 Parents Donors (do this for each class PK-12 and for Little School Parents)
￫Select the Preview button
￫Create a query from each report for exporting purposes.
[bookmark: _k4wr98a8bfyz]￫Export directly from the report preview as a .pdf 

Open the Export Module > Annual Report Parent Export (In the Annual Report Folder)
￫On the Output tab, update the Campaign information on the gifts
￫Export the data
￫After exporting, open the spreadsheet and compare to the .pdf reports and notate the Anonymous Donors.

4. Grandparent Support  (Annual Fund)
Open the Reports Module >Financial Reports >Gift Detail & Summary Reports and select Annual Report Grandparent Donors
1. General tab:
Include Grandparents (be sure the query includes New Grandparents and only HOH)
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
2. Filters tab:
Campaigns/Include Selected, Annual Fund current fiscal year.
3. Format tab:
Title: 2015-16 Annual Report
Subtitle: Grandparent Donors
￫Select the Preview button
￫Export directly from the report preview as both a .pdf and as a Microsoft Excel (97-2003) Data-Only file.
￫Open the exported data & compare to .pdf report and remove anonymous names.
￫Verify unpaid pledges and remove if necessary.
 
5.a. Alumni Support (Annual Fund)
Open the Reports Module >Financial Reports >Gift Detail & Summary Reports and select Annual Report Alumni Donors
1. General tab:
Include All records
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
Report Type:  Detail
2. Filters tab:
Alumni Codes: Include Selected: Alumni; Class Associate; Pape
Campaigns/Include Selected, Annual Fund current fiscal year.
All other tabs should not need updates
￫Select the Preview button
￫Create a query from each report for exporting purposes.
￫Export directly from the report preview as a .pdf 

Open the Export Module > Annual Report Parent Export (In the Annual Report Folder)
￫On the Output tab, update the Campaign information on the gifts
￫Export the data
￫After exporting, open the spreadsheet and compare to the .pdf reports and notate the Anonymous Donors.
￫Split gift amounts on Married Alumni
￫Sort by Class year

5.b. Past Parent Support (Annual Fund)

6. Foundations, Companies, & Organizations (All Funds?)
 
7. Matching Gift Companies (All Funds) Not updated
 ·   	Query Module: SH AR Matching Gifts (Annual Fund)
·   	Open criteria and update Gift Campaign according to FY
·   	Export list of names in .csv format
·   	Copy and paste “unformatted” into MS Word document
·   	Query Module: SH AR Matching Gifts (excluding AF)
·   	Manually add any not already listed as a result of steps 1-3

8. Community Partners (All Funds) Not updated
 
9. Capital Support  (All Capital Funds) Not updated
 
10. Endowments Not updated
(TOTAL ENDOWMENT VALUE at Fiscal Year End TIM KIENE)
·   	Query Module: SH AR Endowment Donors
·   	Open criteria and update Gift Dates according to FY
·   	Export list of names in .csv format

11.a. Honorarium Gifts (All Funds)
Open the Reports Module, select Tribute Reports/Honor/Memorial Contributors/ Honorarium Report
1. General tab:
Include All Records
Include contributors with these gift dates: 7/1/?? – 6/30/??
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
☑ Create output query (for purpose of checking accuracy of names on report): Query: AR Honorarium List
2. Format tab:
Title: Honorarium Contributors List
Subtitle: 2015-2016 (or FYE)
￫Select the Preview button
￫Export directly from the report preview as both a .pdf and as a Microsoft Excel (97-2003) Data-Only file.
￫Open the exported data and compare to .pdf report and remove anonymous names.
￫Verify unpaid pledges & remove if necessary
￫Concatenate in MS Excel to add two spaces before each donor name
￫Remove duplicate donor names
￫Replace anonymous donor names with “Anonymous”
￫Copy & paste into MS Word document “unformatted”
￫Add class years to honoree names where applicable and check the honoree addressees by following these steps:
Open the Export Module and open the export named “Annual Report Honorariums/Memorials”
￫Include selected records: select the query created above: AR Honorarium List
￫Export the query in MS Excel format
￫Compare and correct any names on Annual Report document and correct as necessary
￫Copy & “paste special” into MS Word as “unformatted text”

11.b. Memorial Gifts Not updated
Open the Reports Module >Tribute Reports >Honor >Memorial Contributors and select Memorial Report
1. General tab:
Include All Records
Include contributors with these gift dates: 7/1/?? – 6/30/??
Soft Credit Gifts To  Both
Credit Matching Gifts To  Donor
Include these Constituents:
☑  Inactive constituents
☑  Deceased constituents
☑  Constituents with no valid addresses
☑ Create output query (for purpose of checking accuracy of names on report): Query: AR Memorial List
2. Format tab:
Title: Memorial Contributors List
Subtitle: 2015-2016 (or FYE)
￫Select the Preview button
￫Export directly from the report preview as both a .pdf and as a Microsoft Excel (97-2003) Data-Only file.
￫Open the exported data and compare to .pdf report and remove anonymous names.
￫Verify unpaid pledges & remove if necessary
￫Concatenate in MS Excel to add two spaces before each donor name
￫Remove duplicate donor names
￫Replace anonymous donor names with “Anonymous”
￫Copy & paste into MS Word document “unformatted”
￫Add class years to honoree names where applicable and check the honoree addressees by following these steps:
Open the Export Module and open the export named “Annual Report Honorariums/Memorials”
￫Include selected records: select the query created above: AR Memorial List
￫Export the query in MS Excel format
￫Compare and correct any names on Annual Report document and correct as necessary
￫Copy & “paste special” into MS Word as “unformatted text”
 
12.a. Restricted Gift Donors Not updated
·   	Query Module: SH AR Gifts-in-Kind: Open criteria and update Gift Dates according to FY
·   	Export list of names in .csv format
Copy and “paste special” “unformatted” into MS Word document
12.b. In-Kind Donors Not updated
·   	Query Module: SH AR Gifts-in-Kind: Open criteria and update Gift Dates according to FY
·   	Export list of names in .csv format
Copy and “paste special” “unformatted” into MS Word document

13. Georgia Ed Tax Credit Not updated

14. Ways to Give
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ONLINE EXPRESS (OLX)
Handling Bounced Emails
A bounced email in OLX does not necessarily indicate that it is not a valid email.  On 5.25.17 it was determined that bounces will be handled accordingly:

Constituents with no gifts or none in the last 10 years: Mark their email addresses as	 inactive with the comment "OLX Bounce."

If the constituent has recently made a gift, do not mark the email inactive.  Instead, create an Action on their record to have Director of Annual Giving send an email to attempt to re-engage and hopefully not bounce in the future.



RAISER’S EDGE CONSTITUENT DATA
Annual Data Roll & Updates

Various code changes will occur at the end of the school year. Below is a comprehensive list of those changes.  Please refer to the detailed instruction in this section on how to best facilitate the process.

Data Roll Checklist
This is a helpful list to refer to each summer to use as a check-list  to ensure all updates are completed.

Constituent Code Updates

The following changes may take place prior to exporting the Annual Report data.
· Change New Parents to Current Parents
· Change New Grandparents to Grandparents
· Graduate Email and Education updates

The employee giving data is generally kept on a spreadsheet by the Director of Annual Giving.  Be certain this has been the procedure of the current year prior to changing them.
· Faculty & Staff not returning
· New Faculty & Staff

The following changes should take place only after the Annual Report Data has been exported.
· Graduating Students
· Parents of Graduating Students
· Grandparents of Graduating Students
· Graduating Class Associates
· Graduating previously Withdrawn Students
· Students withdrawing from SCDS
· Parents of Students withdrawing from SCDS
· Little School Students
· Board of Trustees

Attribute Code Updates

The following changes may take place prior to exporting the Annual Report data.
· Parents’ Association Board
· Parents’ Association Liaisons
· Country Fair Chairs
· The Party Chairs
· Alumni Association Board
· Lower School Class Parents & Special Events Chairs
· Middle School Class Parents & Special Events Chairs
Data Roll Instructions
Change New Parents to Current Parents
You must be logged in under the Supervisor level to do the following
· From the query module, create a query of New Parents
· Open the Admin Module > Globally Change Records > Constituent >
“Change 1 - New Parent to Current Parent”

Change New Grandparents to Grandparents
· Create a query of New Grandparents
· Open the Admin Module > Globally Change Records > Constituent >
“Change 1 - New Grandparent to Current Grandparent”

Faculty & Staff Not Returning
· Change constituent code from “FC” to “FF” or “STF” to “FS”. Also add “RT” if a retiree (SCDS HR Department can provide a list of retirees list). Enter the Date From as the last day of contract.
· On Business Information tab, un-check primary business information button.
Add “Date To:” as the last day of contract. Relationship should be “Former Employer” & “Former Employee”.

New Faculty & Staff
add Instruction Here


Graduating Students (their Parents, & Grandparents)
1. Log into RE as “Supervisor”
2. From the Query Module, create a query of “Class of (fill in current graduating year) with constituency code “SCDS Student”
3. Select the Admin. Module
a. Globally change records: Select saved change titled “ Change 3 - Graduating Students”.  Include: Selected Constituents from above query of current graduating class. Be sure to modify date to reflect the current year.
4. Return to Query Module and choose above query again.
5. From the student relationship tab, select each parent and determine if they have any other children who are current students at SCDS. If so, neither the parent nor grandparent records change.
	Otherwise, follow these steps:
The Constituent Code on parent record(s) changes from CP to PP (Past Parent)
The Constituent Code From Date will be added as their child’s graduation date.
The Constituent Code on grandparent record(s) will change as follows:
· If they have other grandchildren currently attend SCDS. Records do not change.
· If the grandparent has made any gifts to SCDS, change the Constituent Code from GP to FG (Former Grandparent).
· The Constituent Code From Date should be added as their child’s graduation date.
· If NO gifts have been made AND they have no other constituent code, delete the record.
Special Note:  Remember to update ALL parent & grandparent records that exist as separate constituents.

Graduating Previously Withdrawn Students  (Class Associates)
Spring 2017: No longer doing this since keeping as Withdrawn until/unless they have another relationship to SCDS, give a gift, attend an event, or otherwise indicate they wish to be brought back into the fold. At that time, you will add the following additional Saluttions: “Alumni Annual Report Listing”, “Alumni Addressee”, “Alumni with date”, and change Miss to Ms.
1. From the Query Module, create a query of “Withdrawn Students of current graduating year” with constituency code “Withdrawn Student”.
2. Log into Raiser’s Edge at the “Supervisor” level.
3. Select the Admin. Module.
a.	Globally change records: Select saved change titled “Change 4 - Graduating Withdrawn
		Students”. Include: Selected Constituents from above query of withdrawn students.

Adding Salutations to Current Graduating Class (Alumni & Class Associates)
1. From the Query Module, create a new query of “Al & CA of Class of current graduating year”. 
2. Log into Raiser’s Edge at the “Supervisor” level.
Select the Admin. Module
	Globally change records using the following saved changes including the class query above:
· “Change 5 – Alum Salutation”.
· “Change 6 – Alum with date”
· “Change 7 - Alum Annual Report Listing”
· “Change 8 – Miss to Ms.”
· Review AL & CA by running query with output of above fields (& email) to manually correct names that use middle name as nickname and verify or update email address.

Students Withdrawing from SCDS (their Parents, & Grandparents)
(see next section for withdrawing Little School students)
1. Change constituent code from “SCDS Student” to “Withdrawn Student” & enter last day of school in the Date From column.
2. Add Solicit Code: Do not solicit
3. From the student relationship tab, select each parent and determine if they have any other children currently attend SCDS. If so, neither the parent nor grandparent records change.
	Otherwise, follow these steps:
The Constituent Code on parent record(s) changes from CP to WP (Withdrawn Parent) unless they have had another child graduate from SCDS. If so, it would change to CP to PP (Past Parent)
The Constituent Code From Date will be added as their child’s graduation date.
The Constituent Code on grandparent record(s) will change as follows:
· If they have other grandchildren currently attend SCDS. Records do not change.
· If the grandparent made any gift to SCDS, the Constituent Code changes from GP to FR (Friend).
· The Constituent Code From Date will be added as their child’s graduation date.
· If NO gift has been made AND they have no other constituent code, the record is deleted.
*Special Note:  Remember to update ALL parent and grandparent records that exist as separate constituents.
4. Obtain the reasons for withdrawal from the Admissions Office and enter in the notes sections of the student & parent records.
5. Create a query of withdrawn students
6. Log into Raiser’s Edge at the “Supervisor” level.
Select the Admin. Module
Globally change records using the following saved changes:
· “Change 6 – Prim Education Date Left & Status” Be sure to modify date to reflect the current year.

Little School Students Withdrawing from SCDS (their Parents, & Grandparents)
1. Change constituent code from “Little School Student” to “Withdrawn Student” & enter last day of school in the Date From column.
2. Add Solicit Codes: Do not solicit & Do not contact
3. From the student relationship tab, select each parent and determine if they have any other children currently attend SCDS. If so, neither the parent nor grandparent records change.
	Otherwise, follow these steps:
The Constituent Code on parent record(s) changes from CP to PP (Past Parent)
The Constituent Code From Date will be added as their child’s graduation date.
The Constituent Code on grandparent record(s) will change as follows:
· If they have other grandchildren currently attend SCDS. Records do not change.
· If the grandparent made any gift to SCDS, the Constituent Code changes from GP to FR (Friend).
· The Constituent Code From Date will be added as their child’s graduation date.
· If NO gift has been made AND they have no other constituent code, the record is deleted.
*Special Note:  Remember to update ALL parent and grandparent records that exist as separate constituents.
4. Obtain the reasons for withdrawal from the Admissions Office and enter in the notes sections of the student & parent records.
5. Create a query of withdrawn students
6. Log into Raiser’s Edge at the “Supervisor” level.
Select the Admin. Module
Globally change records using the following saved changes:
· “Change 6 – Prim Education Date Left & Status” Be sure to modify date to reflect the current year.

Past Parent Non-Donors
Each year we will query past parents who are now 6 years out and have no other affiliation to the school. If they have never given, we will add solicit codes on the Bio 1 tab of the records as DNS/DNC. A note will be added to Notes tab on each record with the current date and Type: RE NXT Summary as follows: Coded DNS/DNC due to lack of activity.
Adding New Records
This section will change with ReNxt
Investigate adding new records through Raiser’s Edge Batch Entry.
New Parents
· Open Raiser’s Edge, Records, Constituents
· Search for parent record
· If parent is already in RE, verify that they are coded as a New or Current Parent.
· If parent not already in RE, add them as follows:
· Select the ‘New Individual’ option
· Bio 1 Tab: Add all information available from app. including home address.
· Bio 2 Tab: Constituent Code: Little School Parent or New Parent, add ‘Date From’
· Addressee/Sal Tab: Add Addressee & Salutation
· Bio 1 Tab: Select the ‘Business’ button on the bottom right.
· Add Business Information
· Save and Close
· Bio 1 Tab: Select the ‘Spouse’ button
· Add Spouse Information
· Form the Spouse, select the ‘Business’ button & Add spouse business information
· Press the save icon
· Click on Relationship at the top of the screen
· Add relationship as a individual
More info here










New Students

· Verify still a student in WH & obtain Start Date
· Scroll to bottom left in WH
· Select ‘Student Enrollment’ to obtain start date
· Open Raiser’s Edge, Records, Constituents
· Search for student record
· If student not already in RE, Add them as follows:
· Select the ‘New Individual’ option
· Bio 1 Tab: Add all information available from app. except address. (Miss or Mr. for students)
· Bio 2 Tab: Constituent Code: Little School Student or SCDS Student, add ‘Date From’
· Addressee/Sal Tab: Add Addressee & Salutation
· Bio 1 Tab: Select ‘Education’ button
· School Name: Savannah Country Day School
· School Type: Little School or if SCDS Student, Primary Education
· Class of:  1800 if Little School student, or add class year if SCDS Student
· Date Entered: same as on Bio 2 tab
· Status: Enrolled
· Save & Close
· Bio 1 Tab: Select the ‘More’ button (just to the right of the address box).
· Select ‘Address’ from the top of screen, ‘copy/share address from’, enter parent name to search, & copy home address from the parent record.
· Add Home telephone #
· Select the ‘Relationship’ tab
· Add all relationships to the student (parents, siblings, grandparents).
· Grandparents are not added to RE for Little School Students but if the grandparent is already in RE, just relate them but do not change their code to Grandparent or New Grandparent until the child moves to Pre-K.

Adding Home Room Teachers & Advisors to Student Records
It is important to add the Home Room Teacher or Advisor names to each student record. This data is used throughout the year for Parents’ Association and for annual giving Solicitation purposes.  The information may be obtained from the various schools.
· Open the Query Module
· Create a query of individuals with Constituent Codes: Includes Selected: “SCDS Student” and save the query
· Open the Export Module
· Select: Home Room Teacher Import.
1.General: Include the query created above
‘HOH’ Processing ⦿ Export both constituents separately[image: ]
	Include these Constituents:
  	☑  Inactive constituents
☑  Deceased constituents
  	☑  Constituents with no valid addresses
			2. Output: See sample.
· Export the Data
· Open the Export in MS Excel
Add teacher names and change headers to include ImpID, ESRImpID (Education import ID), KeyInd (I), and the home room teachers’ names).  

To Import Home Room Teachers:
· Choose Admin → Import → Constituent Import “Home Room Teacher”
New Employees
All employees are added to Raiser’s Edge as follows. For Advancement Office Employees, refer to to the Software Security section of this manual for additional information.
Add info here

Adding New Attribute Codes
You may have a group of people who need a shared attribute (if you are only updating a handful, manually update them on the constituent’s attribute tab).  First, export the group being sure to include the import ID for each record. 
· To add a new attribute, use these headers for your CSV import file: ImportID (constituent import ID), CAttrCAT (attribute category), CAttrCom (optional comments), CAttrDate, and CAttrDesc (required description).
· To update an existing attribute, use these headers for your CSV import file: ImportID (constituent import ID), CAttrImpID (attribute import ID), CAttrCAT (attribute category), CAttrCom (optional comments), CAttrDate, and CAttrDesc (required description).
· Access the Import menu through the Admin tab.
· Select the Import named “Const Attribute Import”
· General tab – import new records if this is a new attribute, create table entries, choose the import file you created with headers above, use the import ID and the format is delimited.
· File Layout tab – comma, field names are on the first line of the import file, and check the headers
· Fields tab – this should already be mapped. See image below:
[image: ]

· Summary tab – create exception file, create output query, create control report and then import. 


· 
· 
Addressee/Salutation Standards
Approved by Craig Brooks 10.2.2015

-If Alum is married, address only the Alum until the couple becomes a parent, grandparent, or other affiliation.

If Alum is married, address only the Alum until the couple becomes a parent, grandparent, or other affiliation.

Suffix
Use a comma and space before the suffix for Jr. and Sr.
Example:	Mr. & Mrs. John Michael Doe, Sr.

Do not use a comma before I, II, III or Ph.D.
Example:	Mr. & Mrs. John Michael Doe II

Prefix
Examples:	Mr., Mrs., Ms., Dr., Drs., Col., Capt., Maj., Rev., Rev. Dr.

Formal Addressees
If the constituent uses Middle Name (or shortened version of Middle Name, always list First Initial, then Middle Name vs. First Name and then Middle Initial.

Non Alum Affiliation Formal Addressee
	Title
	Suffix Scenario
	 Last Name Scenario
	Sample

	Mr. and Mrs.
	Male with Suffix
	Same Last Name
	Mr. & Mrs. John M. Doe III

	Ms. and Mr.
	 
	Different Last Names
	Mr. John M. Doe & Ms. Jane L. Edwards

	Ms. and Mr.
	Male with Suffix
	Different Last Names
	Mr. John M. Doe, Jr. & Ms. Jane L. Edwards

	Male Doctor and Female Mrs.
	 
	Same Last Name
	Dr. & Mrs. John M. Doe II

	Male Doctor and Female Ms.
	Male with Suffix
	Different Last Names
	Dr. John M. Doe III & Ms. Jane L. Edwards

	Female Doctor and Male Mr.
	Male with Suffix
	Same Last Name
	Dr. & Mr. John M. Doe, Jr.

	Female Doctor and Male Mr.
	Male with Suffix
	Different Last Names
	Dr. Jane L. Edwards & Mr. John M. Doe, Sr.

	Both Doctors
	Male with Suffix
	Same Last Name
	Drs. Jane E. & John M. Doe, Sr.

	Both Doctors
	 
	Different Last Names
	Dr. Jane L. Edwards & Dr. John M. Doe



Female Alum Affiliation Formal Addressee
	Mr. and Mrs.
	Male with Suffix
	Same Last Name
	Mr. John M. III & Mrs. Jane Edwards Doe '85

	Mr. and Mrs.
	 
	Same Last Name
	Mr. John M. & Mrs. Jane Edwards Doe ‘85

	Ms. and Mr.
	 
	Different Last Names
	Ms. Jane L. Edwards ’85 & Mr. John M. Doe

	Dr. and Mr.
	 
	Same Last Name
	Dr. Jane Edwards Doe '85 & Mr. John M. Doe

	Dr. and Mr.
	 
	Different Last Names
	Dr. Jane L. Edwards '85 & Mr. John M. Doe

	Dr. and Mrs.
	 
	Same Last Name
	Dr. John M. & Mrs. Jane Edwards Doe ‘85

	Both Doctors
	 
	Same Last Name
	Drs. Jane Edwards Doe ‘85 & John M. Doe



Male Alum Affiliation Formal Addressee
	Mr. and Mrs.
	 
	Same Last Name
	Mr. & Mrs. John M. Doe, Jr. ‘81

	Ms. and Mr.
	 
	Different Last Names
	Mr. John M. Doe III ’81 & Ms. Jane L. Edwards

	Dr. and Mr.
	 
	Same Last Name
	Dr. & Mr. John M. Doe ‘81

	Dr. and Mrs.
	 
	Same Last Name
	Dr. & Mrs. John M. Doe ‘81

	Dr. and Mrs.
	 
	Different Last Names
	Dr. John M. Doe ’81 & Mrs. Jane L. Edwards

	Both Doctors
	 
	Same Last Name
	Drs. Jane E. & John M. Doe ‘81



Married Alums Formal Addressee
	Mr. and Mrs.
	 
	Same Last Name
	Mr. John M. '81 & Mrs. Jane Edwards Doe '83

	Mr. and Mrs.
	 
	Same Last Name/Same Class Year
	Mr. John M. '81 & Mrs. Jane Edwards Doe '81

	Ms. & Mr.
	 
	Different Last Names
	Ms. Jane L. Edwards ’83 & Mr. John M. Doe ‘81

	Both Doctors
	 
	Different Last Names
	Dr. Jane Edwards ’83 & Dr. John M. Doe ‘81

	Both Doctors
	 
	Same Last Name
	Drs. Jane Edwards ‘83 & John M. Doe ‘84

	Female Doctor and Male Mr.
	 
	Same Last Name
	Dr. Jane Edwards Doe ’81 & Mr. John M. Doe ‘84

	Male Doctor & Female Mrs.
	 
	Same Last Name
	Dr. John M. Doe ‘84 & Mrs. Jane Edwards Doe ’81





Constituent Rules (pop-up notes on records)

User Defined Rules in Raiser’s Edge
Purpose: Sometimes a constituent will have a special note that should be seen when opening a record, posting a gift, or posting an action. You can create User Defined Rules to display messages by creating an “Opening Constituent Rule”. 

There are several Constituent  & Gift Rules currently set up in Re7 that may be used for various purposes. Review them prior to creating a new rule. If you find an option that will work for you, then you can your constituent to the existing query used for that rule and then customize the notes on the constituent’s individual record.

Constituent Rules currently in Raiser’s Edge[image: ]



Gift Rules currently in Raiser’s Edge
[image: ]
CREATE A NEW OPENING CONSTITUENT RULE IN RAISER’S EDGE
You must FIRST log into the software at the “Supervisor” level user. The procedure below demonstrates how to make a rule to warn users to take special care when opening the constituent record of a board member. 

1. On the Raiser’s Edge bar, click Config. The Configuration page appears.
2. Click Business Rules. The Business Rules page appears.
3. From the tree view, under User defined rules, select Constituent. The Opening Constituent Rules grid appears.
4. In the grid, any rules defined appear. Rule Name displays the name assigned the rule, Query Name displays the query on which the rule is based, and Message displays the text that appears when a user activates the rule. 
5. On the action bar, click New Opening Constituent Rule. The New Rule for Opening Constituents screen appears.
6. In the Rule name field, enter “Board Member Caution Message” to identify the new rule in the grid on the Business Rules page.
7. In the Query name field, enter the name of the constituent query on which to base the rule, or click the binoculars to find the query. You can select any saved dynamic or static constituent query or create a new one. Queries filter and extract information from the program.
8. We recommend you base your rules on dynamic queries. Dynamic queries automatically update to include any new records you add that meet the query criteria. For this rule, select a dynamic constituent query that includes only those constituent records with the constituent code “Board Member.” 
9. In the Message box, enter the text to appear when the new rule executes. For this rule, the text reads “This constituent is a Board Member. Please use extreme care when entering or editing information in this record.”
10. To apply the rule to only selected security groups, mark Apply Rule to Selected Security Groups Only. The selection box is enabled. To move selected groups from the Security Groups box into the Apply Rule to these Security Groups box, use the arrows. The business rule affects only those groups you move into this box. 
11. To apply the rule to all users, leave Apply Rule to Selected Security Groups Only unmarked. 
12. To activate the rule when the user adds a gift for a constituent coded as a board member directly from the Gifts link of Records rather than from the constituent record, mark Gifts. When a gift is added to a board member’s constituent record, the message appears.
13. To activate the rule when the user adds an action for a constituent coded as a board member directly from the Actions link of Records rather than from the constituent record, mark Actions. When an action is added to a board member’s constituent record, the message appears.
14. To save the new rule, click OK. You return to the Business Rules page. In the grid, the new rule now appears.



EXAMPLES OF SPECIAL NOTES

	J. C. Lewis Foundation, Inc.
	Annual $25,000 Donation to Annual Fund

	
	Soft Credit as follows (per Chuck Izlar)    
	Record ID #

	
	$4,000 
	Nancy N. Lewis
	2257

	
	$3,500 
	Julius Curtis Lewis & spouse, Carol S. Lewis
	941 & 14283

	
	$3,500 
	John Christian Lewis & spouse, Mary R. Lewis
	943 & 969

	
	$3,500 
	David Scott Lewis
	942

	
	$3,500 
	Samuel Wistar Lewis & spouse, Lynn Lewis
	947 & 7521

	
	$3,500 
	Walter N. Lewis
	948

	
	$3,500 
	Nancy V. Lewis
	945

	VERY IMPORTANT:  Never CC Ack Letters to Family per Chuck Izlar 629-9270.

	 
	ALL Foundation Acknowledgment Letters to:
	Mr. Charles Izlar

	 
	
	J.C. Lewis Foundation

	 
	
	Mrs. Nancy N. Lewis, President

	 
	
	P.O. Box 60759

	 
	
	Savannah, GA  31420

	Critz Family Fund of The Savannah Community Foundation, Inc.
	Annual donation to Annual Fund

	
	Soft Credit as follows  (per Dale Critz, Sr.)
	Record ID #

	
	Full Amount of gift to ALL
	Dale Critz, Sr.
	1974

	
	

	Dale Critz, Jr. & spouse, Debbie Critz
	351 & 10793

	
	

	Cay Critz
	350

	Critz Family Fund of The Savannah Community Foundation, Inc.
	Annaul donation to AF from Taylor Critz
	Soft Credit only to           Taylor Critz
	6416

	Mr. & Mrs. Mark & Kim Tate
	Ack Letters & Pledge Reminders to: 
	Mr. Mark Tate

	
	

	Tate Law Group, LLC

	
	

	2 East Bryan Street

	
	

	Savannah, GA  31401

	Mr. & Mrs. T. Mills Fleming
	Ack Letters & Pledge Reminders to: 
	Mr. T. Mills Fleming

	
	

	Hunter, Maclean, Exley, & Dunn, P.C.

	
	

	P.O. Box 60759

	
	

	Savannah, GA  31420


ADVANCEMENT OFFICE NEW HIRE
New Hire Checklist
☐ Citrix & Raiser’s Edge logins (See Software Security section)
  	Email links & give password info to employee
☐ Raiser’s Edge Nxt (See Software Security section)
☐ Printer/Copier user code set-up (See Software Security section)
  	Give access code to employee
☐ Obtain key from Admin Office
  	Give key to employee and advise of alarm code (1474)
 
Review with new employee:
☐ Phone set-up instructions
☐ Office supply room
☐ Shred bin
☐ Mailbox
☐ Outgoing mail area
☐ Stamps
☐ Basic copier tutorial
 

SOFTWARE SET-UP AND SECURITY
Citrix Hosting Site New User[image: ]
·       Log into the Blackbaud Hosting Services (Citrix)
·       Select the User Administration icon.





[image: ]

·       When the User Administration screen appears, right-click in the white area and select New, User.





·       Enter user First Name, Initial, Last Name, Full Name, and User logon name (limited to 20 characters) fields and select Next.
·       Enter a temporary password for the new user and select appropriate check boxes for password options. Select Next and Finish.

·       Right click on the new user’s name in the list on the screen and select Add to Group.
·       Type 1120-REUsers into the white field and select OK.


Raiser’s Edge New User[image: ]
·       Log into Raiser’s Edge as the Supervisor user.
·       Open the Admin Module
·       Select Security, New User
·       Enter user’s last name in lower case.
·       Description (user’s Full Name)
·       Select the Group in which to add the new user to

·       Select the Select This User’s Options button.
1. On the Color tab: Legends, View Gift Legend and set the following and also place in the following order on the list by using the Up and Down Arrow buttons at the bottom.

	 
	 
	Bold
	Named Colors
	Suffix

	Cash
	Black
	✔
	 
	 

	Pay-Cash
	Black
	✔
	 
	 

	MG Pay-Cash
	DarkGreen
	✔
	25600
	 

	Pledge with write-offs
	Red
	✔
	255
	--WO

	Write Off
	Red
	✔
	255
	--WO

	MG Write Off
	Red
	✔
	255
	--WO

	Pledge
	RoyalBlue
	 
	14772545
	 

	Stock/Property
	Black
	 
	 
	 

	Stock/Property (Sold)
	Black
	✔
	 
	 

	Pay-Stock Property
	Black
	 
	 
	 

	Pay-Stock/Property (Sold)
	Black
	✔
	 
	 

	MG Pledge
	DarkGreen
	 
	25600
	 

	MG Pay-Stock Property
	DarkGreen
	 
	25600
	 

	MG Pay Stock/Property (Sold)
	DarkGreen
	✔
	25600
	 

	MG Pay-Other
	DarkGreen
	✔
	25600
	 

	Gift-in-Kind
	DarkViolet
	 
	13828244
	 

	Pay-Gift-in-Kind
	DarkViolet
	 
	13828244
	 

	MG Pay-Gift-in-Kind
	DarkViolet
	 
	13828244
	 

	Other
	Black
	✔
	 
	 

	Pay-Other
	Black
	✔
	 
	 

	Recurring Gift
	RoyalBlue
	 
	14772545
	 

	Recurring Gift Pay-Cash
	Black
	✔
	 
	 

	Soft Credits
	Black
	 
	 
	--SC

	Linked to Proposal
	currently not using
	 
	 
	 

	Transaction Pending
	currently not using
	 
	 
	 



2. On the Records tab : Individual title bar, Set as shown below[image: ]

















Raiser’s Edge Nxt New User
Sign in to Re NXT
Hover over blackbaud in top left corner and Raiser’s Edge Nxt will appear.[image: ]







[image: ]

Hover over Control Panel and select Security.

Send invitation to the new user’s email.
[bookmark: _uu3zoz1mb8u]
[bookmark: _r0pk9f4ywsyl]
[bookmark: _s93kr8ev0z25]
Printer/Copier New User (Ashley’s machine # 19768)
·       On the machine keypad, press the Settings/Registration button
·       Select Log In on the screen
o   Dept ID & Pin are both 7654321. It will prompt you to set up a new one but press cancel.
o   Go to Management Settings, User Management, Department ID Management, Register PIN, Register, Department ID, Enter a four digit user code for the new user. (Use the last 4 digits of the ss# since simple for user to remember although that is not the required code if user has another preference.)
o   It is not necessary to enter a new Department ID since we do not use those.
o   Press OK.
·       To add email, Select Set Destination, Register Destinations, Register New Dest., Enter new user Name and Email address, press Okay.
·       To add Mailbox
        	Function Settings, Store/Access files, Mailbox settings, Set/Register Mailboxes, Okay
·       General User Info.
Copy, scan, fax, color vs. BW, Doc server print



REFERENCE CHARTS
Stock Brokerage Firms

	Firm Name
	Account #
	DTC #
	Contact

	Sterne, Agee & Leach           (PO Box 8346, 31412-9922)
	7279-5460-SV85
	0750
	Donna Yawn: (912) 234-5400, dyawn@sterneagee.com, Asst. to Craig Barrow. If Donna is not in, speak with Cathleen (claing@sterneagee.com) Fax 912-238-1440

	Morgan Stanley Smith Barney
	641-013091-014
	0015 
	Brian Orr: (912) 692-4619, Cell (912) 429-0596, brian.p.orr@mssd.com. Assistant: Sharon: (912) 692-4621

	Charles Schwab 
	8096-5825
	164
	Tim Kiene will handle.  Cindy Lee is local contact.

	Wells Fargo Advisors
	8631-3309
	 
	Kelly Newberry: (912) 921-3400


[bookmark: _ubkdv0f5379b]


[bookmark: _es3iu1m7bsew]General Ledger Codes (Created by Business Office)
General
	GL Code
	Fund
	Notes

	1-4200-456
	Annual Fund
	See below for gifts from Dr & Mrs. Stephen Hendrix or Mr. & Mrs. Ralph Tolman

	1-13pldg year-000
	Annual Fund Multi-year pledge pmt
	Dr & Mrs. Stephen Hendrix or Mr. & Mrs. Ralph Tolman

	1-4200-590
	Horizons
	

	2-4200-779
	Swim Team
	

	2-4200-136
	Upper School Fine Arts
	

	2-4240-773
	Track Capital Unpledged
	

	2-14pldg year-773
	Track Capital Pledge Pmt
	Example: If making a payment that is due for FY 2014-15, GL code would be 2-1415-773

	2-4240-497
	Jenkins Annex Unpledged (Future location of Admissions & Advancement)
	

	2-14pldg year-497
	Jenkins Annex Pledge Pmt (Future location of Admissions & Advancement)
	Example: If making a payment that is due for FY 2015-16, GL code would be 2-1416-497

	2-4240-491
	NFC II General Unpledged
	

	2-14pldg year-491
	NFC II General Pledge Pmt
	Example: If making a payment that is due for FY 2011-12, GL code would be 2-1412-491

	2-14pldg year-490           (except for 2010-11 year)
	NFC I General Pledge Pmt
	Example: If making a payment that is due for FY 2009-10, GL code would be 2-1410-490. One exception: If payment is for pledge year 2010-11, use GL code 2-1311-490.

	
	Investing in Excellence Campaign General Unpledged
	

	
	Investing in Excellence Campaign General Pledge Pmt
	





Restricted
For restricted gifts listed below that are Budget Relieving, notify the Department via email of the gift amount.
For restricted gifts not listed below, contact Emily Foley in the Business Office for a GL Code.
	[bookmark: _4kx3h1s]GL Code
	Fund
	Notes

	1-4940-825
	Arts Alliance
	Special Handling (see Page 9 of Advancement Resource Manual for additional information)

	1-4940-815
	Booster Club
	Special Handling (see Page 9 of Advancement Resource Manual for additional information)

	2-4200-458
	The Wong Community Service Award
	

	2-4200-762
	Crew
	

	2-4200-230
	Chorus
	

	2-4200-650
	Restricted: Shakespeare Garden
	

	2-4200-123
	Lower School Science
	Dr. Campen for aquarium upkeep

	2-4200-100
	Lower School (Box Tops for Education Donations)
	Email Libby Jackson, Gayle Putnal, & Sharon Smith: Depositing a check from Box Tops into GL Code 2-4200-100 to spend from expense account #2-5200-100.

	2-4200-329
	Upper School Fine Arts
	

	2-4200-330
	Restricted: Class of 1975 US Jazz/Strings
	Be sure and select the Tribute tab, all gifts in memory of Ruskin Cooper & Lynn Heptinstall. Notify families.

	2-4220-768
	Restricted: Baseball
	


[bookmark: _qqr7rioxebib][bookmark: _6acq9g2uk7qo]Endowment - 1981 Permanently Restricted
	GL Code
	Fund
	Notes

	1-2840-000 (3-3399-000)
	General Endowment
	

	1-2840-000
3-14pledge year-000 (3-3201-000)
	Andrews Endowment Fund
	

	1-2840-000
3-14pledge year-000 (3-3402-000)
	Hoke Bouchillon Memorial Award
	MG Unpledged

	1-2840-000 (3-3025-000)
	Beulah Harper Nettles Scholarship End
	

	1-2840-000 (3-3210-000)
	Camille M Heery Visiting Artist Fund
	

	1-2840-000 (3-3035-000)
	Jelks Endowment
	

	1-2840-000 (3-3230-000)
	Gongaware Endowment
	

	1-2840-000 (3-3065-000)
	Saunders Endowment
	

	1-2840-000 (3-3075-000)
	Sellers Scholarship Fund
	

	1-2840-000 (3-1417-000) (3-3047-000)
	The T. Miller ‘97 Endowed Scholarship
	


[bookmark: _laibq47enx3d]Endowment - Investing in Excellence
	GL Code
	Fund
	Notes

	1-2840-000 (3-3427-000)
	General Endowment
	

	1-2840-000 (3-3022-000)
	The Harlander Family Endowed Scholarship
	

	1-2840-000 (3-14pledge year-000)
	The Jane Philbrick
Endowed Merit Scholarship
	





Acknowledgment Letter Types

Annual Fund Pledges

	                                Head of School = HS                         Director of Annual Giving = DAG
                Director of Advancement = DA                                                 AF Solicitor = AFS

	Pledge Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	 
	Specified amount
	AF Verbal Pledge
	No
	DAG & cc: AFS

	Verbal Pledge
	Unspecified amount
	AF Verbal Unspecified
	No
	DAG & cc: AFS

	 
	Considering a gift
	AF Considering
	No
	DAG & cc: AFS

	
	
	
	
	 

	 
	Written pledge from Trustee (any amount)
	AF Pledge Trustee
	Yes
	DA & HOS

	Written Pledge
	Written pledge from Employee (any amount)
	AF Pledge Faculty
	Yes (same letter)
	DA & HS

	 
	Written pledge $1-$999
	AF First Pledge, AF Pledge $1-$499, AF, AF Pledge $500-$999
	Yes
	DA

	 
	Written pledge $1,000+
	AF Pledge $1000-$2499, AF Pledge $2500-$4999, AF Pledge $5000-$9999, AF Pledge $10k+
	Yes
	DA & HS



Annual Fund Gifts

	Head of School=HS                                   Director of Advancement=DA

	Gift Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	
Written Pledge Payment
	Payment towards written pledge
	AF Pledge Payment
	Yes
	DA

	
	Fulfillment of written pledge
	AF Pledge Fulfillment
	Yes
	DA

	
	
	
	
	

	
Unpledged Gift
	Gift from Trustee
	AF Gift Trustee
	Yes
	DA & HS

	or
	Gift from employee
	AF Gift Faculty
	Yes
	DA & HS

	Verbal Pledge
	First gift
	AF First Gift
	Yes
	DA & HS

	Payment
	Gift $1-$999
	AF Gift $1-$499, AF Gift $500-$999
	Yes
	DA

	 
	Gift $1,000+
	AF Gift $1000-$2499, AF Gift $2500-$4999, AF Gift $5000- $9999, AF Gift $10k+
	Yes
	DA & HS



Other Special Gifts

	Head of School=HS                                   Director of Advancement=DA

	Gift Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	
	Matching Gift    $1-$999
	MG to Individual
	No
	DA

	
	Matching Gift $1,000+
	MG to Individual
	No
	DA & HS

	
	Honor/Memorial Gift
	AF Honor/Memorial to Donor
	Yes
	DA

	
	

	Note card to honoree or family of memoriam
	No
	N/A

	
	Foundation donor advised gift $1-$999
	AF Found Gift to Donor $1-$999
	No
	DA

	
	Foundation donor advised gift $1,000+
	AF Found Gift to Donor $1,000+
	No
	DA & HS

	
	Gift from graduating senior
	AF Senior first gift
	Yes
	DAG & HS

	
	Gift of Stock            $1-$999
	AF Stock Gift $1-$999
	No
	DA

	
	Gift of Stock     $1,000+
	AF Stock Gift $1,000+
	No
	DA & HS




Capital Campaign Pledges

	Head of School=HS                                   Director of Advancement=DA

	Pledge Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	
Verbal Pledge
	Verbal pledge specified amount
	Capital Verbal Pledge
	No
	DA

	
	Verbal unspecified amount
	Capital Verbal Unspecified Amt
	No
	DA

	
	Verbal considering a gift
	Capital Considering
	No
	DA

	
	
	
	
	

	
Written Pledge
	Written pledge Faculty (any amt)
	Capital Pledge Faculty
	Yes
	DA & HS

	
	Written pledge          $1-$999
	Capital Pledge $1-$999
	Yes
	DA

	
	Written pledge $1,000+
	Capital Pledge $1,000+
	Yes
	DA & HS









Capital Campaign Gifts

	Head of School=HS                                   Director of Advancement=DA

	Gift Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	Gift Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	Written Pledge Payment
	Payment towards written pledge
	Capital Pledge Payment
	Yes
	DA

	
	Fulfillment of written pledge
	Capital Pledge Fulfillment
	Yes
	DA

	
	
	
	
	

	Unpledged Gift             or            Verbal Pledge Payment
	Gift from employee
	Capital Gift Faculty
	Yes
	DA & HS

	
	Gift $1-$499
	Capital Gift $1-$499
	Yes
	DA

	
	Unpledged Gift $500+
	Capital Gift $500+
	Yes
	DA & HS




Capital Campaign Special Gifts

	Head of School=HS                                   Director of Advancement=DA

	Gift Type
	Description
	Letter Name(s)
	Ltr(s) in Re7?
	Acknowledged by

	


Special Gifts
	Matching Gift
	Capital MG to Company
	Yes
	DA

	
	

	Capital MG to Individual
	No
	DA

	
	Foundation donor advised gift $1-$499
	Capital Found Gift to Donor $1-$499
	No
	DA

	
	Foundation donor advised gift $500+
	Capital Found Gift to Donor $500+
	No
	DA & HS

	
	Gift of Stock              $1-$499
	Capital Stock Gift $1-$499
	No
	DA

	
	Gift of Stock     $500+
	Capital Stock Gift $500+
	No
	DA & HS
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